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1. Drafting a Hood
For the first tutorial we will be following a set of drafting instructions written by Finnish designer Leena
Lähteenmäki.  These instructions are provided in the following pages.  You may find it helpful to refer to the original
instructions as you work through this tutorial; however, this is not an exercise in how to translate written
instructions to MacroGen commands.  (We’ll get to that a little later in Tutorial 2.)

This tutorial is designed to acquaint you with the MacroGen environment, the main features of the program, and the
most important commands you will need to know in order to begin your own project. These instructions in Tutorial 1
will tell you what steps to follow, and how to do them, but not necessarily why to do them.  We just want to get
you up and going with MacroGen, and let you see how easy it is to accomplish things.
If you want more explanation on the commands themselves than what is provided here, you can find detailed
information in the Help file.

BEGINNING A NEW PROJECT
We will begin by assuming you have successfully installed
MacroGen from the PatternMaker CD or download.
When you start MacroGen you will see this dialog box
Click “New” to begin a new project

The Style Manager opens. 
On the left side it lists all the pieces the macro will create.  
A Base piece is already there.

Type “Hood” in the field called “Macro Title.” 
Type "Hood" again under the field called Name
and click the “Add Piece” button.The word
"Hood" appears in the piece list on the left.  

The Piece that is highlighted on the left will appear
on the right side under the Style Tree.
it is possible to make more style options to this
Piece. 
(In PatternMaker while running the macro you will
get a style form with the style options to choose
from.)

Highlight "Hood" under Style Tree
Click the "Show” button.

(Note: In MacroGen, a "Piece" can consist of more than one drawing object.  For example, a “Piece” may be an entire pair
of pants, with the individual pattern pieces (front, back, facings, waistband) being different drawing objects in the same
Piece window.)  For simplicity, in this first tutorial the hood will be a single ob ject.)
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A blank editing window opens, the Pattern Area.

On the left you see the area where the pattern will be
drafted, beginning from the Start point.

On the right side a Tab panel with the tabs Measure,
Point and Object is showing.

In the title bar you can read which file (if saved) and style
have been opened  (Tutorials - Hood.mg4 file and .[Hood]
style.)

Save your file with the name "Tutorials - Hood" by using the
Save icon.

Automatically a Designers folder in My documents/
PatternMaker/Personal files will open, where all MacroGen
projects can be saved. 
Note: You will find examples of all the tutorial files in the folder
Tutorials.

THE MACROGEN ENVIRONMENT
Let’s take a look around here for a moment.
The main window takes up most of the space, with a tabbed panel to the right.  There is a standard file menu along
the top, with a row of buttons underneath.  All of the design functions are available in the tabbed panel, and every
command is available from the menu.
You can zoom in and out by using the commands on the Zoom menu.

SET THE MEASUREMENT UNITS
Before we do anything, we need to tell MacroGen we will be working
in centimeters.  For your own projects, you can use either inches or
centimeters, but since we will be working along with Leena’s
instructions, we will use centimeters throughout all these tutorials.
On the Settings menu (the upper menu, not the panel), click the
word “Metric” so that it is clearly selected.
Select: Settings/ Metric
Okay, now we’re in metric.  Let’s move on.
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SET THE DEFAULT MEASUREMENTS
The first main step in designing your new macro is to define the default
measurements that the user will be asked for as the macro is run.  
The macro will take these inputs, put them into equations that you've set up, and
then draw the objects that result.

Select from the tab panel the tab Measure / Add / Prompted Measure

A form appears with the title "Prompted Measurements".

Create a measurement called "Neck" (neck
circumference) and give it a default value of 33.5

Measure Name->Neck
Value->33.5
Click "Picture" edit field

A windows browser form appears and the folder
MeasurePictures opens.You can scroll to the folder
Tutorials where all files for the Tutorials are saved. (My
documents/PatternMaker/Personal files/Designers) 
Select file "Hood Width.jpg"(you can only select .jpg
files with a maximum of 400x400 pixels)

Click the "New" button on the left side.

Note: By clicking the New button you just added the measurement to the Measurements list at the right side. 
It will also appear later on in the Measure/Edit list, with the default value (33.5) in parentheses.

In the name field "New" is appearing. 
Overwrite this with the name of the second
measurement called "Height" (height of hood).  
Give it a default value of 40.

Measure Name -> Height
Value -> 40
Click "Picture" edit field
Select file "Hood Height.jpg" in the folder Tutorials

Click the "Save" button and then the Ok button.

Note: don’t worry about the "Measurements Table field in this form.  It will be covered in a later tutorial.
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Both measurements are saved now, and you will be returned to the Piece window. The Piece window is where you
will see the points for the hood appear as you create them.  Right now the hood only has one point, named Start. 
In the title bar of this window you can see which piece/style is opened. At the moment the piece [Hood] is opened
from the file Hood.mg4 .

ENTERING NEW POINTS
Now that we have some default measurements, we can start entering points.  The first point we create will be of the
“Coordinate” type.
A point created with the Coordinate Point method (short for Coordinates) is always measured from one single other
point.  You determine a reference point (the From point) and then tell MacroGen how far away the new point is and
in what direction.  If the From Point's location is changed (usually because the user entered different
measurements which moved it), this dependent point will be changed, also.

A BRIEF DIVERSION
If you need to visualize what’s happening here, imagine a grid with an X axis (horizontal measurement) and a Y
axis (vertical measurement).  The point you are measuring from is always at the center of the grid, at the
intersection of the X axis and the Y axis.  This is similar to working with gridded pattern paper.  You use the grid to
keep lines straight, but also to determine how far one point is from another.

Sometimes you will know exactly how far apart two points are (“Point B is always 2cm from Point A”).  
This is a fixed distance. No matter what body measurements the user enters, Point B will always be 2cm from
Point A.

At other times, you will not have a specific number in mind. 
You may know only that the distance from Point A to Point
B is equal to some body measurement – the arm length, the
center back length, the neck circumference, etc.  This will
be different for each person who uses your macro.  
In this circumstance you cannot use a fixed number.  You
must use a variable.

The location of a new Coordinate point is always relative to its From Point, modified by the values you enter.  If you
use the Offset fields, the distance will be fixed – the point is always “offset” by such-and-such amount.  If you use
the X-Measure and Y-Measure fields, the distance will be variable – based on the measurements input by the
user.

The Scale values let you use fractions or multiples of the measurements.  It is the number the Measurement is
divided by.  For example, if you select “Waist Circumference” for your Measurement, and set a Scale of 4, the
user’s waist measurement is divided by four.  (That is, one-quarter the user’s waist measurement.)

You can read more about Offsets, Measurements and the Scale feature in the MacroGen Help file.
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BACK TO ENTERING POINTS…
From the Tab panel select the Point Tab, select Add / Coordinate
The Add / Edit coordinate point form opens.
The first point added will be called A.  Point A will be located at the Start point (X
and Y offsets of  0).

Note: It is better that the Start point is
not part of the drawing. This can cause
problems later with Editing in PM.
Therefore we make a new first point
from which we draw other points (you
could also give in an X and Y offset

from Start).

Follow the illustration to the left and
enter the following information:

Point Tab 
Add / Coordinate
Name : A
From : Start
X Fixed Distance : 0
Y Fixed Distance : 0

Click "OK".

In the piece window, Point A is located right on top of point Start.
If you don't see your new "A" point, click the "All" button at the
top.

Note:  Use the X and Y "Fixed Distance" boxes to fine-tune the
placement of your coordinates

We're going to draft a rectangle whose width is 1/2 the neck
measurement, so let’s mark out this distance: 
Add another Coordinate Point (Select “Add/Coord” from the Point
tab).  
This point will be measured from Point A.  
The distance of Point B from Point A is equal to the measurement
"Neck" with a Scale of 2 (“Neck” divided by 2). Since this is a
variable, use the Measure fields rather than the Fixed Distance fields:

Point Tab / Add / Coordinate
Name: B
From: A
Y Measure: Neck
Y Scale: 2

Click “OK”. 
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Now point B appears in the piece window:

Comparing this result with our drafting instructions, it’s clear right
away that we’ve made a mistake.  Point B is supposed to be
directly to the right of Point A, not above it.  
What happened?

We filled in the Y measure while it supposed to be the X measure.

CORRECTING A MISTAKE
If you find you’ve made a mistake in entering a point, there’s an easy way to correct it.
Click on the point in the display to bring up the Coordinate window of point B, where you can
make the necessary changes.

Point B:  click Left Mouse (we type LM)
Y Measure: (None)
X Measure: Neck
X Scale: 2

Click “OK”. Now Point B appears in its proper place:

Add another Coordinate Point (Point/Add/Coordinate). 
Point C marks the height of the rectangle, so it's measured
from point B in a vertical (Y instead of X) direction.  
The scale factor of -1 means the direction in which it is
measured is reversed (down instead of up).

Point / Add / Coordinate
Name: C
From: B
Y Measure: Height
Y Scale: -1

Click the “OK” button.

RESIZING THE PIECE WINDOW
Depending on the size of your piece window, you may not be able to see all of the points you just entered.  

   Try adjusting your zoom level with the buttons.      
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Now we’ll enter Point D to complete the rectangle.  
To create it, we’ll use a Rectangle point instead of Coordinate.  
Choose Point Tab  /Add / Rectangle.  
The Rectangle point type means that no matter where points A and C are
placed, D will automatically be put at the corner of the rectangle they
define:

Point Tab /  Add / Rectangle
Name: D
X-Coordinate: A
Y-Coordinate: C

Your drawing should now look like the illustration
below.  If it does not, remember that you can edit a
point by pointing at it and clicking when the cursor
turns to a hand.

Point E marks a point halfway down the rectangle.  
Add a point midway between A and D (Point/Add/Center).  
A Center point will always be placed halfway between the two
points it's based on.

Point Tab / Add / Center
Name: E
From: D
To: A

ALTERNATE WAYS OF SELECTING COMMANDS
All MacroGen commands can be selected in two ways: menus and the tabbed panel.  The tabs on the panel
correspond to the commands on the pull-down menus and are specific designed for an easy use of managing the
points, measure and objects commands.
In the instructions so far, you've been instructed to select commands from the tab menus for getting to work with
the tab panel.  
If you can’t remember what a particular icon (button) is for, just point at it with
your mouse.  A yellow ToolTip pops up at the cursor location, and a longer
description is displayed in the message bar at the bottom of the main
MacroGen window.

As you can see in the menu and in the ToolTip example above, some
commands also have a Hot Key assigned to them.  Hot Keys are assigned
to the most commonly-used commands.  You can use whichever selection
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method feels most convenient to you.

Click the "Point tab in the tabbed panel,
and then click the "Add" tab

From here, you can simply select the option you want by
clicking on the appropriate icon in the list.

Select "Coordinate" from the list and continue on.

ENTER REMAINING POINTS
Point F marks where the curve at the back of the hood
begins. 
It will always be the same distance from point B (Point/
Add/Coordinate), so use a Fixed Distance value:

Select Point / Add / Coordinate
Name:  F
From:  B
X Fixed Distance:  -8

Point G marks the other end of the curved section.  
It lies on a line from C to B, 8 cm from B.  
The "Continue" point type puts a new point on a line drawn through any two existing points.  
A negative Fixed Distance means that you begin at the start point and head toward the end point (moving in a
“positive” direction), and then when you reach the end point, come back in a “negative” direction for a certain
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distance. 
(By contrast, in other circumstances you might continue to move in a positive direction from the start point past the
end point to the destination.) 
In this case, the location of Point G is determined by beginning at Point C, heading toward Point B, then reversing
8cm (a “negative” distance) on that line to arrive at Point G. (Read more about the Continue point type in the Help
file.)

Select  Point / Add / Continue
Name:   G
Start:   C
End:   B
Fixed Distance:   -8

Notice that we've just used two different methods (Coordinate and Continue) to do
practically the same thing with points F and G.
In this situation, either one works.

Your drawing should now look like this:

Points H, J, K, and L will mark out a curved line at the bottom of the
hood.  The width of the hood is divided into halves, quarters, and
eighths, so we'll use the Center point type repeatedly:

Select Point / Add / Center
Name: H
From: C
To: D
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Select Point / Add / Center

Name: J
From: C
To: H

Select Point / Add / Center

Name: L
From: D
To: H

Select Point / Add / Center

Name: K
From: L
To: H

Check that your drawing is correct to this point:
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The original instructions tell us to move Point A 2 cm away
from the rectangle.  MacroGen doesn't move a point after
it's already been used, so instead we'll define a new point
and call it A2:

Select Point / Add / Coordinate
Name: A2
From: A
X Fixed Distance: -2

Note:
When the list of points to choose from is longer you can scroll to
the right point to select it or just type in the point name and
MacroGen will jump to it in the list.

We also need to place points D2, K2, and L2 on a curve below the bottom of the hood.  These points are based on
D, K, and L. (In other words, points A, D, K, and L aren't really part of the pattern.  They are intermediate values
used as part of a two-step process to calculate the actual points needed.  When you get into a situation where a
point's location requires a complicated calculation, there will usually be more than one way to translate the original
drafting instructions to the MacroGen tools.  There is no particular "right" method.)

You will notice later that although points A, D, K, and L appear in the object window, they won't be used to create
objects and therefore won't be seen in the final pattern.

Select Point / Add / Coordinate
Name: D2
From: D
Y Fixed Distance: -3
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Select Point / Add / Coordinate
Name: L2
From: L
Y Fixed Distance: -3

Select Point / Add / Coordinate
Name: K2
From: K
Y Fixed Distance: -1.5
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CHECK ALL THE POINTS
Now we've finished entering all the points that will make
up the hood.  Check that your drawing looks like the
illustration below:

Remember that you can use Zoom All (Ctrl+A) or click the
"All" button  if some of the points are outside the viewing
area.

You can also scroll with the mouse wheel to zoom in or out.

CONNECT THE DOTS
As you’re adding points, the editing window doesn't show an actual drawing object (a pattern piece).  What you see
is only a representative view of the points that can then be used to draw the hood.  Now it's time to create an
object, and tell MacroGen what points to use.  This is a little bit like a connect-the-dots puzzle.

Select Object / Add
from the Tab panel

Click the "New"
button
Type " Hood" under
"Object Name"
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Now, in the main window, left
click on the point A2.
We will write this dow as:
A2  -  LM  (Left Mouse)

In the point list you'll notice
that A2 is added.  
You can't tell yet, but you have
begun a line.

Add the rest of the points:

F -  LM

B  -  LM
G  -  LM
C  -  LM

 F -  LM

 B -  LM

 G -  LM

 C -  LM

CHANGING A POINT TYPE
We've made another deliberate mistake.  The section from point F to Point G should be an arc, not a square
corner.  We need to change point F to type Arc.

Double-click F on the screen or in the panel list
The Connection box comes up:

Select XArc Start
Click OK

In the list after F [ XArc] will appear 
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You choose XArc Start, because point F is where your first arc (curve) begins.
MacroGen changes automatically point B in a Cornerpoint.
In the list you will see B [Corner]

Note:
You also can click on point B and choose for XArc Corner. Point F would have been
changed into an XArc Start point

(That's better.) 

The next point J is the start of an arc rather than a simple line.  

First:
J  -  LM
H  - LM

Now, double-click on J again (on the screen or in the list) to bring up
the Connection Box, and select XArc Start.
The next point after the start point of an arc is automatically a corner
point.  Don't worry that you didn't see anything happen when you
clicked on  it, or if you see the line section disappear.  When you add
the next point, the whole arc will appear.
Click OK to exit the form

K2  -  LM
Click RM now or Double-click K2 in the panel to open the
Connection form
and change the type to XArc Start.
E  -   LM

DELETING A POINT FROM AN OBJECT
This is another mistake.  To delete E, bring up the Connection Box, so doubleclick at point E on the screen or in
the list of points.
(E should be the corner point of an arc that begins at D (not D2) and ends at A2, the start point of the object.) 

E  -  doubleclick LM (Connection box opens)
Select: Delete -  OK
L2  -  LM
D2  - LM

D  -   LM
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Now we are changing point D into a XArcStart point

D  -  RM or double-click LM (in the main window or in the points
list)
Select XArc Start  - OK
E  -  LM (will be a XArcCorner point)

Click the "Closed" checkbox in the
Object tab.  
When the Closed checkbox is checked,
MacroGen closes the object by
connecting its first and last points.

You're done making the Hood object. 

The OK button in the tabbed panel
completes the job.

Click: OK

Now the object is finished. 

When you forget to click  OK or Cancel after adding or editing an object MacroGen will give you a
message to click  OK or Cancel.

HIDING/DISPLAYING POINTS
Having too many points showing on screen together can interfere with your work.  Points can be switched off
selectively, which makes the object appear less cluttered.
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WITH POINTS TAB

Bring up the panel again and click
the "Point" tabs and select "Edit".

You can hide every point on the
drawing screen by checking the hide
box in the display list of points.

Check the following points:
Start
A 
J 
L 
K

check the Hide box to hide a point on

the screen

Your drawing displays only the points that are actually used in the hood object.

Click ing the Hide All or Hide None buttons will hide all points on the
screen or display all points at once.

WITH OBJECT TAB

A different way of showing of hiding the points can be done in the
Object Tab.
To see only  these points  that  are used in the Hood object  go to the
Tab Object and select the Edit Tab.
Select with LM the Hood object in the list and click RM.
A right mouse menu appears to choose from several options:

Rename the object
Show Points used in this object
Hide the points used in this object
Show all points made in this style
Hide all points made in this style

SAVE THE FILE AND CONVERT TO A MACRO
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Save your file once more with the Save File icon in the Status bar.
The file will be automatically saved in the folder Designers in My documents/PatternMaker/Personal Files
You can add here sub folders if you want.
We have added a sub folder Tutorials where you will find all the MacroGen example files of the Help and Tutorials.

 Create Macro
Now that your MacroGen project has all the logic set up, you can create a macro from it using the Create Macro
Icon (as in PatternMaker).
or File/Create Macro.

You won't see anything visible happen when you do this.  However, in the background, MacroGen has created a
macro file based on the same name as your project file (and saved it in the same directory) .
You have just created a macro (Tutorial - Hood.MAC) file. 

Test macro
To test this macro you can start PatternMaker from MacroGen with the Test Macro Icon and see the results:
or select “Test Macro in PatternMaker” from the File menu.
PatternMaker will launch and automatically run the Hood macro.
See how the hood is drawn with the default measurements.
Close PatternMaker (do not save changes) to return to MacroGen.

If you wish, repeat the test as above, but type different numbers into the measurements dialog box when it
appears.  Compare to the first version of the hood pattern.
Close PatternMaker again, and do not save changes.
You will automatically return to MacroGen

Continue on to Tutorial 2 to learn how to translate written drafting instructions into MacroGen!
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2. Translating Drafting Instructions Pants
The design of the hood was laid out in a way that made it very simple to transform it into a macro.  Most designs
are not as straightforward.  
Tutorial 2 covers something a little more complicated: a pair of pants, drafted by our Designer Leena. 
For now, we will simply read over the drafting instructions and translate them into a form that will make it easy to
input into the macro generator. 
In tutorial 3, we’ll use these notes and observations to actually plug numbers into MacroGen.

The full text of Leena’s drafting instructions is included in the end of this chapter (see drafting instructions Leena's
pants ).  However, for working here step-by-step, we’ve separated out her instructions and printed them

“In a line that looks like this”
to clearly differentiate Leena’s instructions from our comments and explanations.

IDENTIFYING THE NECESSARY MEASUREMENTS

To begin, open  in the folder Tutorials the pants macro Tutorials - Pants.mg4.  In the Style Tree select  the Ladies

Pants and click the Show button.  Click the Measure tab at the top of the panel, and then the Edit tab on the left
(you can widen the list by left-clicking and dragging the left edge of the panel to the desired width).

SIMPLE BODY MEASUREMENTS
The first step is to plan the list of body measurements with a set of
default values.  For this lesson we will use Leena’s default Ladies’
measurements.  The complete charts are available on her web site;
here we have reproduced the relevant measurements for the pants.

If some of the listed measurements look unfamiliar to you, keep in
mind that Leena uses the Scandinavian Drafting System.  The
system you use may require different measurements.  That's okay…
for your own designs you can use the system you prefer.  For the
purpose of these tutorials, however, we ask that you temporarily
accept this system, assume for the moment that it does in fact work
nicely, and follow the instructions as written.

The default measurement numbers do not have to be "right," since
we only need reasonable estimates for the time being. The user will
be putting in his/her own numbers when the macro is run.

   

All Measurements are listed in centimeters:

Waist Circ 78 Hip Height 19

Abdm Circ 95 Outside Seam Length 105

Hip Circ 102 Knee Circ 54

Crotch Depth 27.5 Cuff Circ 40

Abdm Height 9

MODIFIED BODY MEASUREMENTS
Next we note that some of these measurements are modified.  We need to make a note of how they are modified:

32
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If Abdmn Circ > (“is greater than”) Hip Circ then Hip Circ = Abdm Circ

Waist Circ = Waist Circ + 2 (for ease at the waist level)

Hip Circ = Hip Circ + 4 (for ease at the hip level)

Later we will be setting up “rules” to tell MacroGen how to handle these modified measurements.  To add 2cm ease
at the waist, for example, we will set up a rule that tells MacroGen, “ignore the actual waist measurement and
always use Waist Circ + 2 instead.”

CALCULATED MEASUREMENTS
“Do the following calculations:”
This step tells us to divide some of the measurements by constants.  We can skip this step in our planning
because when we define points in MacroGen, we can use Scaling values to multiply or divide measurements on the
spot.

PLANNING THE POINTS
Next we come to the actual drafting instructions.  You may be able to do these steps in your head once you get
comfortable with MacroGen, but for now, take the time to write them out.

NOTATION TIPS:

Number each point sequentially and title the line with the point's number.

As you study each step, draw a picture of where the point will be in the draft.

Experiment to find a notation method that works for you.  Throughout this tutorial, we will use two different methods
of representing the points.

shorthand: Anything surrounded by ( ) is the name of a point.  Anything surrounded by [ ] is an offset value.

table: This layout gives you a simple left-to-right  display  of what  to enter in the Add Points  windows.   The
fields are listed in the same order as you will encounter them on the forms.

DRAFT A FRAME FIRST

What points do you need to draft in MacroGen?  
Generally, you need to plan on using points for four different purposes:

guide points
These  are  used  to  calculate  other  points  but  aren't  actually  part  of  the  pattern.   For  instance,  if  your
instructions tell  you to draw a box outlining the measurements  of a bodice,  you'll  need to create some  guide
points to show where the box is.  Points marking neck, waist, and hem lines are also common.

intermediate points
These are also points that  don't  show up in the final pattern,  but  they are used to help calculate other points.
 When  your  instructions  tell  you  to  do  something  that  can't  be  done  in  a  single  step  with  MacroGen,  the
solution  is  usually  to  plot  one  or  more  intermediate  points,  then  base  the  next  point's  location  on  the
intermediate  point.   Remember  Points  D,  L,  and  K  from  the  hood  in  Tutorial  1?   Those  were  intermediate
points, used to add Points D2, L2, and K2 later.

points that are part of the pattern
These are the ones that you'll actually connect with lines to make the pattern.   Most  of them will  also be used
as guide points.

curve control points
Remember that PatternMaker's  arcs  have control points  that  are part  of the drawing,  but  don't  show up in the
pattern.   Your  drafting  instructions  won't  have  these,  so  you  need  to  remember  to  add  them  yourself.
 Estimating where they should go is an art you'll learn with practice. 
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We can use a single point to represent a perfectly vertical or horizontal line.  Unlike a paper sketch, MacroGen
doesn't need drawn guide lines, as long as you have the points the lines are based on.  Many of the MacroGen
functions do the equivalent of matching lines, using the X and Y coordinates of one or two points.

LET'S GET STARTED!
When the Start point is a part of our drawing, this could cause problems later on with editing the drawing.
Therefore, we first create a new first point a couple of cm offset to Start. This point S will be a coordinate from Start
with a X fixed distance of 5.

Coordinate (S) =
 (Start) + [5, none/1]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S Start None 1 5 None 1 0

“Start by drawing a vertical line that corresponds to the outside seam length of the pants.”

Coordinate (1) =
 (S) + [0, Outside Seam/-1]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

1 S None 1 0 OS -1 0

What this means to me is that I'm creating Point 1 using the Coordinate method. Its "from" point  is  S.   Its  position

will  be 0 in the X direction (horizontal) and -Outside Seam in the Y direction (vertical).   The  “-”  sign  in  the  Scale

fields indicates that the direction is down (below the “from” point, rather than above it).

“Draw a horizontal line at the top of the vertical line.  This is the waist line of the pants.”
We don't have to do anything here since the Start point can be used as the marker for the waist line

“Draw a horizontal line at the bottom of the vertical line.  This is the cuff line of the pants.”
Once again we don't need to do anything more.  Point 1 does this for us.

“Measure down from the waist line a distance equal to the abdomen height and draw a
horizontal line.  This is the abdomen line.”
Again, this is a Coordinate point because it is measured from one existing point (the waist line).  “-1” indicates a

down direction.

Coordinate (2) =
 (S)+ [0, Abdm Height/-1]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

2 S None 1 0 Abdm.H -1 0

“Measure down from the waist line a distance equal to the hip height and draw a horizontal
line.  This is the hip line.”

Coordinate (3) =
 (S) + [0, Hip Height/-1]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

3 S None 1 0 HHt -1 0

“Measure down from the waist line a distance equal to the crotch height and draw a horizontal
line.  This is the crotch line.”

Coordinate (4) =
 (S) + [0, Crotch Height/-1]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

4 S None 1 0 CHt -1 0

“Find the point midway between the crotch line and the cuff line.  Draw the horizontal knee line
6cm above this point.”
There is no single command that will do this.  We are going to have to use a combination of the Center method and
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the Coordinate method.  Point (5) is an intermediate point.

Center (5) =
 { (1) ,( 4) }

Pt. Name From To

5 1 4

Center (6) =
 (5 ) + [0, 6]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

6 5 None 1 0 None 1 6

The Y Fixed Distance of “6” means Point 6 is placed 6cm vertically from Point 5.

PANTS FRONT
We've just done the equivalent of drawing the guide lines that determine the overall shape of the pants.  Now, we're
going to go through the instructions and plot the rest of the pants, step by step.  Are there any more major
decisions we have to make before we start drafting points?  Leena's drafting instructions are organized so that from
this point on, you can just go around the pattern and plot each point.  If you're making a macro of your own
patterns, you may need to think ahead here and make sure you're doing things in the order they need to be done.

“Divide the waist circumference (+ease) by 8.  On the waist line, measure this distance to the
left from the pants center line.  Mark this point as the center front point of the waist.”
This  will  be a Coordinate point,  because it  is  measured from one single existing point  (the  pants  center  line,  the
Start  point).  Measuring to the left  requires  using  a  negative  number  in  the  Scale  field;  “8”  indicates  that  we  are

dividing the Waist Circ measurement by 8.  (Remember, wherever you see Waist Circ, it actually equals Waist Circ

+2 because of the added ease.)

Coordinate (7) =
 (S) + [Waist Circ/-8, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

7 S WC -8 0 None 1 0

“Divide the waist circumference (+ease) by 8 and add 3 cm.  On the waist line, measure this
distance to the right from the pants center line.  Mark this point as the side front point of the
waist.  Of the extra 3 cm, +2 cm is for the dart and +1 cm is to move the side seam 1 cm
towards the back to prevent them from showing.  The side point is raised by 1 cm.”
This  step uses a Coordinate point  with a combination of the Measurement,  Scale and Offset  fields.   Using  an  X-

Scale of “8” is how we indicate that the Waist Circ measurement is divided by 8.  The X-Offset  of “3” represents  the

3cm added to that waist amount.

Coordinate (8) =
 (S) + [Waist Circ/8 + 3, 1]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

8 S WC 8 3 None 1 0

“On the waist line, measure 4.5 cm to the right from the pants center line and start the front
dart from there.  Make the dart 2cm wide.  The dart extends from the waist line to the abdomen
line.  Draw the right side of the dart so that it forms a right angle where it meets the abdomen
line.”

This is going to require us to create three points.  The first (9) is the start of the dart.  (10) is the end of the dart. 

(11) is the center of the dart.

Coordinate (9) =
 (S) + [4.5, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

9 S None 1 4.5 None 1 0

Coordinate (10) =
 (9) + [2, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

10 9 None 1 2 None 1 0
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Since Point 11 forms a right angle with an existing line (represented by a single point, in this case), we can use the
Rectangle point type.  Remember, this point type uses a horizontal position (X) of one point and the vertical
position (Y) of a second point.
For Point 11, we’ll use the X (sideways) position of Point 10, and the Y (up-and-down) position of Point 2.

Rectangle (11) =
 { (10), (2) }

Pt. Name XCoord YCoord

11 10 2

Now we notice that the last leg of the dart isn't as long as the first leg.  We can fix this by creating another point.  
We will have to create an Distance measure to ensure that the distances always match.  
The measurement M1 will represent the distance from Point 9 to Point 11, whatever that happens to be.  Using an
Distance measurement ensures that both legs of the dart are always the same length.

Distance measure (M1) =
Distance { 9, 11}

M. Name From To

M1 9 11

Now we use M1 as the Y Measurement for Point 12:

Coordinate (12) =
 (11) +  [0, M1]]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

12 11 None 1 0 M1 1 0

“Divide the hip circumference (+ ease) by 8 and subtract 2cm. On the hip line measure this
distance to the left from the pants center line.  Mark this point as the center front point of the
hip.”
The instructions tell us to place the point to the left of the pants’ center.  We know that  this  means it  will  be in the

“negative-x” direction.   But  subtracting 2 from that  number means we are  decreasing  that  distance;  it  is  actually

less than the 1/8-hip measurement.  So we move “not as  far” in the “negative-x” direction,  or,  back in the “positive-

x” direction.  This is why the X Fixed Distance of “2” is positive, rather than negative.

Coordinate (13) = (3) - [ Hip Circ/8 - 2 , 0]

Or more simply:

Coordinate (13) =
 (3) + [Hip Circ/-8 + 2 , 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

13 3 HC -8 2 None 1 0

“Divide the hip circumference (+ ease) by 8 and add 2 cm.  On the hip line measure this
distance to the right from the pants center line.  Mark this point as the side front point of the
hip.”
“Measure to the right” means the Scale will be a positive number.  “Add 2cm” means we are increasing the distance

from the center line; therefore the X-Fixed Distance of “2” is a positive number.

Coordinate (14) =
 (3) + [Hip Circ/8 + 2 , 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

14 3 HC 8 2 None 1 0

”Draw a vertical line from the center hip point downwards to the crotch line and mark this
point.”
We will use the Rectangle point type again here.  The X (side-to-side) position matches the center hip, Point 13,
and the Y (up and down) position matches the crotch line, Point 4.

Rectangle (15) =
{ (13), (4) }

Pt. Name From To

15 13 4

“From the marked point (15) measure x-1 cm to the left and mark.  Mark this point as the tip of
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the front crotch curve.  ‘X’ is calculated by dividing the hip circumference by 20.”
Again,  we’re  measuring  “less  than  X”  to  the  left.   That  means  the  Scale  is  negative  (to  the  left),  but  the  Fixed

Distance is positive (back towards the right).  The Scale of “-20” divides Hip Circ by 20,  and places the point  to the

left of Point 15.

Coordinate (16) =
 (15) + [Hip Circ/-20 +1 , 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

16 15 HC -20 1 None 1 0

We could also have created a math. measure for Hip Circ.  You will often find more than one way to accomplish
something.  It is a simply a matter of preference.

“Divide the desired knee circumference by 4 and subtract 1 cm.  On the knee line measure this
distance to the left and to the right from the pants center line.  Mark these points as the knee
point of the front pant.”

To measure to the left of the knee point, we use a Scale of “-4.”  The X Fixed Distance of “1” moves the point back
to the right.
To measure to the right of the knee point, the Scale is positive.  The X Fixed Distance of “-1” moves the point back
to the left.

Coordinate (17) =
 (6) + [Knee Circ/-4 + 1, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

17 6 KC -4 1 None 1 0

Coordinate (18) =
 (6) + [Knee Circ/4 - 1, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

18 6 KC 4 -1 None 1 0

“Divide the desired cuff circumference by 4 and subtract 1cm. On the cuff line, measure this
distance to the left and to the right from the pants center line.  Mark these points as the cuff
point of the front pants.”
These cuff points are positioned in the same way as the knee points.

Coordinate (19) =
 (1) + [Cuff Circ/-4 + 1, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

19 1 CC -4 1 None 1 0

Coordinate (20) =
 (1) + [Cuff Circ/4 - 1, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

1 1 CC 4 -1 None 1 0

PLANNING A CURVE
Before playing connect-the-dots and placing all the lines we need to think about where we want to have curves. 
Curves can be a bit tricky because they require a corner point.  The corner point controls the amount of curvature. 
Also, the designs never clearly state where a corner point should be placed.  We have to use some intuition to
figure out where they need to go.

There are a few rules to remember in placing corner points:
A. To have a curve join cleanly to a line, have the corner point be on the continuation of the line.
B. This means that if you want a curve to smoothly connect two lines, the corner point needs to be at the

intersection of those lines.
C. To have a corner point connect cleanly to another curve, place the new corner point on the line formed by the

corner point and the connecting point of the previous curve. 
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In other words, the above two rules apply if you use the first curve’s corner point as part of an imaginary line.
D. To have a curve come off a line at a right angle, have the corner point be at a right angle to the line.
E. The same applies to a curve coming off of a curve.

In the illustrations below, the green Xs represent the corner points.  The shape of the curve is controlled by moving
the corner points.  Moving the corner point farther from the end points (blue) results in a sharper curve (not shown).

A. Curve joining a line B. Curve joining two

lines

C. Smooth curve-to-

curve

D. Curve at a right angle E. Angle curve-to-curve

We are going to place corner points in two places: the crotch and the line connecting the hip and waist.  First, let’s
figure out the corner point for the hip.  We want it to flow smoothly from the leg, so, according to rules A and B
above, the corner point needs to be part of both the leg line and the waist line.  We can achieve this by placing the
point at an intersection of the two lines.

Line Line Intersect (21) =
 { (18)-(14), (7)-(Start) }

Pt. Name 1 Start 1 End 2 Start 2 End

S21 S18 S14 S7 S

Next comes the crotch curve.  Again, we are going to want it to flow smoothly down from the waist center front line,
but it also needs to come in at a right angle to the leg line.  We can't intersect with the crotch line (represented by
Point 4), because that isn't perpendicular to the leg line.  We will have to create a point that is perpendicular, and
then use that point as part of a line.  Then we will intersect the two lines.

Right Angle (22) =
 { (17), (16), 5}

Pt.
Name

From Corner Dist Meas Scale Dir

22 17 16 5 None 1 CW

(Notice that although we chose “5” for the distance, it is an arb itrary choice since we are only using it to define a line. 
MacroGen doesn’t care how long or short the line is.)

Line Line Intersect (23) =
 { (16)-(22), (7)-(13) }

Pt. Name 1 Start 1 End 2 Start 2 End

S23 S16 S22 S7 13

CONNECT THE POINTS FOR PANTS FRONT
Now it’s time to play connect-the-dots.  The points are connected as follows:

 7 Line
13 XArc 
23 Corner
16 Line
17 Line
19 Line
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20 Line
18 Line
14 XArc 
21 Corner
 8 Line
12 Line
11 Line
 9 Line
Close the object

ADD A ZIPPER FACING

“Draft the facing for the zipper, 3 cm wide and 18-20 cm high (according to the length of the
zipper you are going to use), at the top of the front pant's center line”
Point 24 is the width of the zipper facing (3cm).  The X Fixed Distance of “-3” puts Point 24 to the left of Point 7, the
waist center front:

Coordinate (24) =
 (7) + [-3, 0]

Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

24 7 None 1 -3 None 1 0

For the purposes of this lesson, we will use a fixed zipper length of 20cm.  Point 25 needs to represent a position
20cm below Point 7, along the line from Point 7 to Point 13.  To “continue” an existing line to a new point, we will
use the continue line type.

If we knew that  the distance from Point  7 to Point  13 was,  for example,  15cm and would never change,  we could
simply  say,  “start  at  point  7,  go  through  point  13,  and  continue  on  for  5  more  centimeters”  to  equal  20cm.
 However, the distance from 7 to 13 will be different for each person.  Therefore, the only  way to make sure that  we

measure  20cm  from  Point  7  is  to  begin  at  Point  13,  measure  up  to  Point  7,  then  measure  back  down  20cm.

 Wherever we end up is  where Point  25 will  be located.   (Theoretically,  this  could  be  on  either  side  of  Point  13,
especially if a different zipper length is used.)

Continue (25) Pt. Name Start End Meas Scale Dist

25 7 13 None 1 -20

Point 26 forms the bottom of the zipper facing.  It is a right angle off of the line formed by Points 7 and 25, and it is
3cm wide:

Right Angle (26) =
 { (7), (25), 3 }

Pt.
Name

From Corner Dist Meas Scale Dir

26 7 25 3 None 1 CCW

Finally, we will connect the points to create another new Object, the zipper facing:
 7 Line
24 Line
26 Line
25 Line

Now that you have an overview of what we’re going to be doing, let’s go ahead and do it in Lesson 3.
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2.1 Leena's pants drafting instructions
This lesson shows how the patterns for the basic pants are drafted according to the Scandinavian pattern drafting
system. 

MEASURING
Read carefully the measuring instructions. To draft patterns for pants, you have to take the measurements listed in the
table below. To keep the pictures clear and readable the measurements are given only in centimeters. You can change
centimeters to inches using formula 1 cm = 0.4 inches.

ADDING EASE
You would not be able to wear the pants if the patterns were drawn exactly to your body measurements. Therefore you
have to add ease to some of the measurements. The basic pants usually are a tight fitting garment and therefore only a
small amount of ease is added.

ADD TO THE WAIST CIRCUMFERENCE: 2 cm
ADD TO THE HIP CIRCUMFERENCE: 4 cm

Do not add any ease to other measurements.
Write down the measurements in the table below.

Body measurement Body measurement + ease

WAIST CIRCUMFERENCE * +2 cm=

ABDOMEN CIRCUMFERENCE *

HIP CIRCUMFERENCE
 (if your abdomen circumference is more
than your hip circumference, use it for your
hip circumference)

* + 4 cm=

CROTCH DEPTH *

ABDOMEN HEIGHT *

HIP HEIGHT *

OUTSIDE SEAM LENGTH *

KNEE CIRCUMFERENCE
The desired finished leg circumference at
knee

*

CUFF CIRCUMFERENCE
The desired finished leg circumference at
cuff

*

DO THE FOLLOWING CALCULATIONS:

Body measurement + ease Divided by 8 Divided by 4 Divided by 20 = x

Waist circumference * *

Hip circumference * * * *

Knee circumference * *

Cuff circumference * *

Round the measurements up to the nearest 0.5 cm.
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DRAFTING THE PATTERNS

Draw a frame first.
Start by drawing a vertical line that corresponds to the outside seam length of
the pants.
Draw a horizontal line at the top of the vertical line. This is the waist line of the
pants.
Draw a horizontal line at the bottom of the vertical line. This is the cuff line of
the pants.
Measure down from the waist line a distance equal to the abdomen height
and draw a horizontal line. This is the abdomen line.
Measure down from the waist line a distance equal to the hip height and
draw a horizontal line. This is the hip line.
Measure down from the waist line a distance equal to the crotch height and
draw a horizontal line. This is the crotch line.
Find the point midway between the crotch line and the cuff line. Draw the
horizontal knee line 6 cm above this point.

FRONT PIECE
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Waist and dart
Divide the waist circumference (+ ease) by 8. On the waist line, measure this
distance to the
left from the pants' center line. Mark this point as the center front point of the
waist.

Divide the waist circumference (+ease) by 8 and add 3 cm. On the waist line,
measure this distance to the right from the pants' center line. Mark this point as
the side front point of the waist. Of the extra 3 cm, +2 cm is for the dart and +1
cm is to move the side seams 1 cm towards the back to prevent them from
showing. The side point is raised by 1 cm.

On the waist line, measure 4.5 cm to the right from the pants' center line and
start the front dart from there. Make the dart 2 cm wide. The dart extends from
the waist line to the abdomen line. Draw the right side of the dart so that it
forms a right angle where it meets the abdomen line.

Hip
Divide the hip circumference (+ ease) by 8 and subtract 2 cm. On the hip line,
measure this distance to the left from the pants' center line. Mark this point as
the center front point of the hip.
Divide the hip circumference (+ ease) by 8 and add 2 cm. On the hip line,
measure this distance to the right from the pants' center line. Mark this point as
the side front point of the hip.
Draw a vertical line from the center hip point downwards to the crotch line and
mark this point. From the marked point, measure x- 1 cm to the left and mark.
Mark this point as the tip
of the front crotch curve. X is calculated by dividing the hip circumference (+
ease) by 20.

Knee and cuff
Divide the desired knee circumference by 4 and subtract 1 cm. On the knee line, measure this distance to the left and to
the right from the pants' center line. Mark these points as the knee points of the front pant.
Divide the desired cuff circumference by 4 and subtract 1 cm. On the cuff line, measure this distance to the left and to the
right from the pants' center line. Mark these points as the cuff points of the front pant.
Now you are ready to draft the front piece pattern. Follow the points that you have marked according to the above
instructions. If the difference of the waist and the abdomen/hip circumference is a lot, there may be a disturbing angle at
the side seam at the abdomen line.
In such a case round the line a bit outwards between the waist and the abdomen line (not marked in the picture). Curve
the inseam a bit inwards between the crotch and the knee (not marked in the picture).
Draft the facing for the zipper, 3 cm wide and 18- 20 cm high (according to the length of the zipper you are going to use), at
the top of the front pant's center line .

BACK PIECE
Draft the back piece pattern in the same frame with the front piece.
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Waist points of the center back and the side back seam
Draw a small rectangle, 1.5 cm wide and x- 1.5 cm high, to the left starting at the
top of the pants' center line (drawn in red in the picture). Mark the top left corner
of this rectangle as the waist point of the back center seam.
Divide the waist circumference by 4, add 2.5 cm and subtract 1 cm. Trace this
distance from the previous point towards the waist line at side raised by 1 cm
(as in the front) (drawn in cyan in the picture below). Of the distance +2.5 cm is
for the dart and - 1 cm is to move the side seams backwards (the corresponding
amount was added to the front waist). Mark the intersection of this line and the
waist line (raised by 1 cm, as for the front) as the waist point of the back side
seam.

Hip points of the center back and side back seams
Draw another rectangle, x+1 cm wide and x- 1.5 cm high, to the left from the
intersection of the hip line and the pants' center line. Mark the top left corner of
this rectangle as the hip point of the back center seam.
Divide the hip circumference by 4. Trace this distance from the previous point
towards the hip line at side (drawn in blue in the picture below). Mark the
intersection of this line and the hip line as the hip point of the back side seam.

Back crotch
Measure a distance of x- 1 cm to the left from the tip of the front crotch curve and
1- 1.5 cm downwards from it. Mark this point as the tip of the back crotch curve. X
is calculated by
dividing the hip circumference (+ ease) by 20.

The knee and the cuff points of the back pant
Mark these points 2 cm to the left and to the right from the corresponding points
of the front pant.
Now you are ready to draft the back piece pattern. Follow the points that you have
marked according to the above instructions. Draft a smooth line from the waist
point to the hip point. The abdomen line of the back pant starts from the
intersection of the back side line and the frame abdomen line and is parallel to
the hip line of the back pant.
Draw the back center seam smoothly according to the picture. Back dart is 2,5
cm wide. Place it at the
midpoint of the back waistline. Vertically the back dart extends to the midpoint
between the abdomen and the hip height.

Note : Please notice that the back piece inseam length measured from the crotch to the knee is to be 1- 1.5 cm shorter
than that of the front inseam. The reason for this is that it reduces the amount of fabric under the buttocks in order to
achieve a better fit of the back pant. You must stretch the back inseam from the crotch to the knee when attaching it to the
front inseam.

Copy right 1998 Leena Lahteenmaki
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3. Drafting Ladies' Pants
For this tutorial we will again be following the set of drafting instructions written by Finnish designer Leena
Lähteenmäki that we already explained in Tutorial 2   
In this Tutorial 2, we worked through the drafting instructions and created an “outline” of the points we were going to
add into MacroGen.  Now we are ready to actually enter the points and create the macro for ladies’ pants.

SETTING UP THE BASICS
Open MacroGen. Click the New button (Begin a new project).  The Style Manager automatically opens.
Check Settings on the menu to make sure you have it set to Metric.

CREATE A PANTS PIECE AND DISPLAY IT
In the Macro Title field, type “Ladies Pants.”  This is the text that will appear in the measurements dialog box
when the macro is run.
In the New Piece Name field, type “Ladies Pants” again, and then click the “Add” button.

Macro Title: Ladies Pants
New Piece Name: Ladies Pants
Click: Add

Highlight "Ladies Pants" under Style Tree

(the Piece "Base" is a default piece which is empty. You can
overwrite this piece with your own name.)

Click the “Show” button

A blank editing window opens, with a tabbed panel on the right.

ENTER PROMPTED MEASUREMENTS
From the tabbed panel from the top row of tabs, select Measure, and then Add from the side row of tabs.  Click
Prompted Measure 
(you can also select Measure/Add/Prompted Measure from the menu).

The Prompted measurements form appears.
Enter the Body Measurements. We call them prompted because when running the macro they are asked to fill in.
Give each one a name and a default value.  
Click at the left side the "New" button to save this measure and enter the next one.  
Remember that we’re estimating on “Knee Circumference” and “Cuff Circumference.”

Click the "Save” button after you have entered the last measure Cuff Circ .
Click the OK button to close the prompted measure window
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MEASURE / ADD / PROMPTED MEASURE
Measure Name:

Waist Circ

Abdm Circ

Hip Circ

Crotch Depth

Abdm Height

Hip Height

Outside Seam Length

Knee Circ

Cuff Circ

Default value:

78

95

102

27.5

9

19

105

54

40

Note:  If you misspell one of your measures, or you want to change a default measurement, click  the
measure on the right side in the list so it is selected and the name appears at the left side. 
Make your change and click  Save again. You can also select the measure through Measure/Edit and
then select the measure from the list.

SETTING CALCULATION RULES
In Part A, we made some notes on certain body measurements that must be modified in order to use them in the
macro – specifically, the waist and hip circumference measurements.  Now we need to tell MacroGen how to
modify them and under what circumstances.

Using the menu, select Point/Logic.  
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In  this  Logic  form,  we  can  define  certain  “If”  conditions  that  MacroGen  will  check  for.   Use  this  feature  to  add

flexibility to your designs.  For example, you might create a rule that says, 
“If the person’s bust circumference is between X and Y, then the neckline depth equals this;
 if the bust circumference is between Y and Z, then the neckline depth equals that.”  
The Steps window displays the “If” conditions, while the Result(s) window shows the end result.

For now, we will add the conditions that Leena’s instructions have laid out for us:

Rule 1: If your abdomen circumference is larger than your hip circumference, use it for
your hip circumference.

Set the IF condition:
Click on the “New Step” button.  The Step form opens. 

Click: New Step

This form is read from the center outward (blue highlighted measure):

“(IF) [a measurement] is [greater than/less than/equal to] [another measurement]…”

Select Abdm Circ from the drop-down list in the center of the form.

Select " > " (“greater than”) from the <==> drop-down list right of Abdm.Circ.

Select Hip Circ from the Measure drop-down list at the far right of the form.

The formula you filled in will appear as the name of the step ( if Abdm Circ > Hip Circ ) in the Name field.

CONDITION:  IF ABDM CIRC > HIP CIRC

Leave the rest of the fields on this form the way they are for now, and click the “OK” button to return to the Logic
form.
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To set the THAN result:

Highlight “Abdm Circ > Hip Circ”.

Click on the “New Result...” button.

The Edit Measure form appears; 

Search for the Hip Circ measure and double-click it 

The Math form of the Hip Circ measure opens:

Since Hip Circ has been selected as the starting point for the
new result, it appears first, under "Name". 
Now, set "First Measure" to Abdm Circ.  
So, this result is saying: "Hip Circ = Abdm Circ."  
(In the graphic above, there is no second measure or additional
number (constant) added for now).
Click OK to return to the Logic form (picture down).

Now that the result shows up in the "Result" window, the form
can be read from left to right as:
 "If Abdm Circ is greater than Hip Circ, then  Hip Circ equals
Abdm Circ."  
All that does is to replace the user's Abdm Circ measurement
with the hip measurement IF the Abdm Circ measurement is
larger.
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Click OK.
Next, select Point/Logic from the menu once again:

Rule 2 : Add 2 cm ease to the waist circumference measurement.

Rule 3 : Add 4 cm ease to the hip circumference measurement.

(Note that there is no IF in these rules.  They’re saying always add ease to the waist and hip measurements.)

Click on the “New Step” button.
Check  the “Always True” check box In the name field
True will appear (when there is already a true step it will
be True(1) etc.
All the other boxes will gray out.
This indicates that whatever you enter in the
corresponding “Results” form will be carried out under any
circumstances 
-- in other words, two centimeters will ALWAYS be added
to the measurement the user enters.

Leave the other fields blank.  Click the “OK” button to
return to the Logic form.

Highlight the “true” entry in the
“Steps” list (and notice the radio
button at the right side is set to
“true”). 

f the condition “true” appears first in
the list and you want it to appear
second, you can use the down arrow
on the left to change its position.  

With “true” highlighted, click the “
New Result” button. The Edit
measure form  opens.
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Select Waist Circ. from the list and click OK or
double click Waist Circ. in the list.

Here you are defining a rule that will always be
carried out:
 “Set the Waist Circ measurement to the existing
Waist Circ  + 2 cm.”

So now, enter "2" as your Fixed Distance,
and click OK to return to the Logic form.

Note:  If your design required it, you could add two Measurements together using this same method.  
For example, if your measuring system takes separate Front Waist and Back Waist measurements,
you could define a rule that says, "Waist Circ equals Front Waist + Back Waist".  If you wanted to do
that and add ease all in one step, you would again enter the "2" in the field at the far right.

With the “True” condition still highlighted, click on the
“New Result” button to repeat the previous steps, this
time specifying Hip Circ.

Enter "4" as your constant (Fixed Distance), and click
OK to return to the Logic form.

There are now two Results listed which correspond to
the “True” Condition.

Note:  The result(s) column only displays the results that correspond to the highlighted Condition. If
you don't have "true" highlighted in the above illustration, you'll see a different set of results

Click on the first Condition in the list.  Notice that the Results list changes.
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Note:  MacroGen carries out the rules in the Calculation Rules form in the order in which they
appear.  This order is important. 
Here, we compare Hip Circ and Abdm Circ (the first condition we created) before we add 4 cm to Hip
Circ

Click the OK button to return to the main window.

ENTERING THE POINTS TO DRAFT THE FRAME

Using the tabbed panel, click Point and Add.  Click on Coordinate (at the top of the list).

This is the Coordinate form, which we learned about in Tutorial 1.  Follow your notes from Lesson 2 and enter the
numbers in the appropriate fields.

When the Start point is a part of our drawing, this could cause
problems later on with editing the drawing. Therefore, we first
create a new first point a couple of cm offset to Start. 
 

Point / Add / Coordinate

Name: S
From: Start

X Fixed: 5

Here, the first point in your drawing will be point S, drawn 5 cm to
the right from Start. From here you start to draw the other points.
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Point / Add / Coordinate

Name: 1
From: S
Y Measure: Outside Seam Length
Y Scale -1
Y Fixed: 1

Here, you have created the line for Outside Seam Length (Point 1):
Next, create the Abdomen Line (Point 2):

Point / Add / Coordinate

Name: 2
From: S
Y Measure: Abdm Height
Y Scale: -1
Y Fixed: 0



Tutorial 3. Drafting Ladies' Pants 45

© 2003-2015 PatternMaker Software

Create Hip Line (Point 3):

Point / Add / Coordinate

Name: 3
From: S
X Fixed: 0
Y Measure: Hip

Height
Y Scale: -1
Y Fixed: 0

Create Crotch Line (Point 4):

Point / Add / Coordinate

Name: 4
From: S
Y Measure: Crotch Depth
Y Scale: -1
Y Fixed: 0

Find crotch-cuff midpoint (Point 5).  
For this we will use the CENTER point type.
Again, follow your notes from Lesson 2:

Point / Add / Center

Name: 5
First Point 1
Second Point 4
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6 cm up from Point 5 is the Knee Line (Point 6) :

Point / Add / Coordinate

Name: 6
From: 5
Y Measure: (None)
Y Fixed: 6

Check your drawing at this point and make sure
that your points are in the right places:

Click the Zoom All button to make all the points
on screen visible.

Point Start is hided here, see the checkbox

Tip:
With check ing the Hide box in the Point/Edit list you can hide points on the screen or make them
visible.
With the Hide All/Hide None button you hide/show them all at once.
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ENTER POINTS FOR PANTS FRONT

Divide the Waist Circ by 8 (Point 7) and mark it to the left
(“negative” direction) of Start.  This is the waist center front
point:

Point / Add / Coordinate

Name: 7
From: S
X Measure: Waist Circ
X Scale: -8

Mark the point to the right (Point 8).  
This is the waist side front point. 

Remember, the Scale divides Waist Circ by 8, and
the X Offset and Y Offset of “3” and “1” respectively
put Point 8 an additional 3cm further to the right and
1cm up.

Point / Add / Coordinate

Name:    8
From: S
X Measure: Waist Circ
X Scale:      8
X Fixed:      3
Y Fixed:      1
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Find the dart start point.  
This is 4.5 cm from the center (horizontal or X direction),
on the waist line (vertical or Y direction):

Point / Add / Coordinate

Name: 9
From: S
X Measure: (None)
X Fixed: 4.5

Create the point on the other side of the dart (Point 10) :

Point / Add / Coordinate

Name: 10
From: 9
X Measure: (None)
X Fixed: 2
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Create the dart apex (Point 11). 
 
We use the Rectangle point type because Point 11 is the
same position left-to-right as Point 10, and the same position
up-and-down as the abdomen line (represented by Point 2):

Point / Add / Rectangle

Name: 11
X-Intersect: 10
Y-Intersect: 2

ADDING A NEW MEASUREMENT

Notice that one side of the dart (between Point 9 and Point 11) is longer than the other (Points 10 and 11).  Both
sides of the dart need to be the same length, so that the dart can be sewn closed.  To fix this we need to create an
Distance measure that will represent the distance from Point 9 to Point 11.  Regardless of how the distance from
Point 9 to Point 11 is changed by the user’s measurements, M1 will always represent whatever that distance is.

From the tabbed panel, select Measure and Add.
Click Distance.

The “Distance" measurement form opens:

Measure / Add / Distance

Name: M1
From Point: 9
To Point: 11

This Distance measure is different from the measures you've created in two ways. 
First, it's calculated internally by the macro, instead of being entered by the user.  In fact, the user of the macro
never sees measurement M1.  
Second, when the macro runs, M1 is not calculated until this point--since it depends on Points 9 and 11, M1 has
no meaning until they've been created.  But once you create M1, it works just like any other measurement.
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Now to create the true end of the dart on line 11-10, we

will use the length M1 to position the point at the end of
the dart:

Point / Add / Coordinate

Name: 12
From: 11
Y Measure: M1
Y Scale: 1

Again, compare your drawing to these two screen shots.  The left shot shows the design window tightly minimized,
while the one to the right shows a segment of the same window after scrolling in close with the mouse.
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Create the left hip point (Point 13).  
The Hip Circ measurement is divided by 8; the negative
Scale makes the point go to the left of Point 3 rather
than to the right. 

Remember, however, that since that resulting number
needs to be made smaller (“subtract 2cm”), the point is
moved back towards Point 3, which is in the positive
direction.  Thus, the X Fixed Distance is a positive “2.”

Point / Add / Coordinate

Name: 13
From: 3
X Measure: Hip Circ
X Scale: -8
X Fixed: 2

Create the right hip point (Point 14).  
Again we divide the Hip Circ by eight, but this time we
are adding 2cm, so the X Fixed Distance is again a
positive “2.”

Point / Add / Coordinate

Name: 14
From: 3
X Measure: Hip Circ
X Scale: 8
X Fixed: 2
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Drop straight down to create the crotch point (Point 15). 

This is another Rectangle point type, because we are
matching the X position (side-to-side) of one existing point
and the Y position (up-and-down) of another existing point:

Point / Add / Rectangle

Name: 15
X-Coordinate: 13
Y-Coordinate: 4

Create the front crotch curve end point (Point 16).  
This point uses the “X” measurement noted at the beginning
of Leena’s drafting instructions.  
X was supposed to be equal to Waist Circ divided by 20.

Since the Coordinate point type offers the Scale field, we
can have MacroGen do this math for us automatically.  

The Scale of “-20” divides the Waist Circ by 20 and places

the point to the left of Point 15.  Again, a positive X Fixed
Distance of “1” moves that point 1cm back toward Point 15.

Point / Add / Coordinate

Name: 16
From: 15
X Measure: Hip Circ
X Scale: -20
X Fixed: 1

Create the left and right knee points (Points
17 and 18).  

To measure to the left and subtract 1 (Point
17) the Scale is negative and the X Fixed
Distance is positive.  

To measure to the right and subtract 1 (Point
18), the Scale is positive and the X Fixed
Distance is negative

Point / Add / Coordinate

Name: 17
From: 6
X Measure: Knee Circ
X Scale: -4
X Fixed: 1
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Point / Add / Coordinate

Name: 18
From: 6
X Measure: Knee Circ
X Scale: 4
X Fixed: -1

Create left and right cuff points (Points 19 and
20).  
Use the same reasoning as above for the
points to the left and to the right.

Point / Add / Coordinate

Name: 19
From: 1
X Measure: Cuff Circ
X Scale: -4
X Fixed: 1
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Point / Add / Coordinate

Name: 20
From: 1
X Measure: Cuff Circ
X Scale: 4
X Fixed: -1

Create the point that will be the corner control point for the hip
curve (Point 21).  
In Tutorial 2, we learned that the key to connecting two lines
(in this case the outside leg line and the waist line) with an arc
is to position the corner point at the intersection of the two
lines.

From the tabbed panel, select Point and Add, and then Line
Line Intersect.
Select the start points and end points for each of the two lines:

Point / Add / Line Line Intersect

Name: 21
Line 1 Start: 18
Line 1 End: 14
Line 2 Start: 7
Line 2 End: S

For the crotch curve, we first have to create a point that is perpendicular to the leg line.  Since a perpendicular line
forms a right angle, we can use the RIGHT ANGLE point type.
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From the tabbed panel, select Point and Add, and then Right
Angle.
Point 22 is at a right angle to the line formed by Points 17 and
16.  
The  Distance field indicates how far away Point 22 will be
from the line.  In this case, it doesn’t matter what number you
enter for the Distance.  Point 22 doesn’t become part of the
pattern; it is only used to define a line.

By checking the "C-Clockwise" box, we tell MacroGen in

which of two possible directions to go when taking the

perpendicular.  In this case, it remains un-checked.

Point / Add / Right Angle

Name: 22
From: 17
Corner: 16
Distance: 5

Now intersect the line from the waist center front (Points 7 and
13) with the line formed by Point 16 and the new Point 22:

Point / Add / Line Line Intersect

Name: 23
Line 1 Start: 16
Line 1 End: 22
Line 2 Start: 7
Line 2 End: 13
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All of the points:

NEW OBJECT: CONNECT THE POINTS         

Now that all the points have been entered, it’s time to connect the points and create the actual pattern piece.
From the tabbed panel, select Object and Add, and then click the New button. Each object must have a name.
This is where you name the specific pattern pieces – in this case, the Pants Front.  Type the name of the piece in
the “Name” field at the top of the form.
You learned how to add points to an object in Tutorial 1. 
Now that you have calculated all those points, what follows is easy.  Follow your notes from Part A to connect all
the points in the Pants Front:
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  7  -  LM (click with LM on point 7 on
screen)
13  -  LM  RM PointType / XArc Start
- OK
23  -  LM  (in list it becomes
automatically a Corner point)
16  -  LM
17  -  LM
19  -  LM
20  -  LM
18  -  LM
14  -  LM  RM PointType/XArc Start -
OK
21  -  LM  (in list it becomes
automatically a Corner point)
  8  -  LM
12  -  LM
11  -  LM
  9  -  LM
Closed:  - checked

Click OK.
Now your drawing should look like this:

Congratulations!
Click OK.

Note:
In the list of points in the ob ject you will
see the following Abbreviations:
L = Line )
X = XArc Start 
C = XArc Corner
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ADDING MORE OBJECTS
According to your notes from Tutorial 2, you also
need to create a zipper facing.  Up to this point,
every pattern you have seen has consisted of a
single drawing object, but it's perfectly legal to
create more objects.  First, though, we need to
define some more points.

ENTER POINTS FOR ZIPPER FACING
Point 24 defines the top width of the zipper facing.

Point / Add / Coordinate
Name: 24
From: 7
X Measure: (None)
X Fixed: -3

For Point 25 we get to use the CONTINUE point type for the
first time.  
This point type is very handy.  Once you feel comfortable with
it, you’ll find it very helpful in a variety of situations.
As explained in Tutorial 2, this point will lie on a line defined by
two existing points (Points 7 and 13).  Since we don’t know
what the distance from 7 to 13 will be for any particular person,
the only way to make sure that Point 25 is always 20cm away
from Point 7 is to begin the “definition” of the line at Point 13,
go up to Point 7, and then measure back down 20cm.  
This establishes the location for Point 25. 

Add Point 25:

Point / Add / Continue
Name: 25
Start Point: 13
End Point :  7
X Measure: (None)
X Fixed: -20
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Point 26 establishes the bottom width of the zipper
facing.  
We will use the RIGHT ANGLE point type again in
this situation.

Point / Add / Right Angle
Name: 26
From: 7
Corner: 25
Distance: -3
C-Clockwise : not checked

NEW OBJECT: CONNECT THE POINTS

Click the Object tab and the New button.  Scroll in
close so that you can see the upper left area. Enter a
name for the facing and then connect the points:

Objects / New Object

Object Name: Zipper Facing

  7  -  LM
25  -  LM
26  -  LM
24  -  LM
Closed:  - Checked

Click OK.
Here’s the zipper facing:

SAVE,  CREATE AND TEST THE MACRO

  Click the “Save” icon on the File toolbar  or select “Save” from the File menu.

Give your macro a name, such as “Pants.mg4” and click the “Save” button. You can create sub folder if you want
to save this file.

  Click “Create Macro” icon  from the File toolbar, or select the “Create macro”  from the File menu.

A macro is created from your Pants project to be tested and used in PatternMaker. It will be saved in the same
folder as your mg4.file
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You can test the macro in PatternMaker by clicking the Test Macro button, or select the “Test macro
from the File menu.

ADVANCED PRACTICE
Have the macro prompt for the zipper length.  
Create a prompted measurement called “Zipper Length” and then edit point 25 to use that Measurement rather
than a Fixed Distance of 20.
Test the macro in PatternMaker and see if the zipper length is asked in the macro.



Tutorial 

4
4. Editing in PatternMaker
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4. Editing in PatternMaker
One of the most powerful features of the PatternMaker/Macro Generator combination is the ability to create the
basic design of a macro in MacroGen and export it to PatternMaker. Then you can use the editing tools of
PatternMaker to cut, rotate, move, copy or mirror the pattern pieces.  When the changes are sent back to
MacroGen, your macro will reflect the changes made in PatternMaker.

You can use this procedure to create options in your macro, such as neckline styles, or pants with pleats vs.
darts.  Editing with PatternMaker saves you time, because you only have to create the “base” garment in
MacroGen one time.

In Tutorial 3 we created a pair of pants with a front dart.  In Tutorial 4, we’ll use this editing capability to create a
pleated option in the macro.  We’re working once again with instructions by Leena Lähteenmäki.

LOAD AN EXISTING MACRO
Start MacroGen and open the Pants macro (Pants.
mg4 file) you saved at the end of Tutorial 3.  
The Style Manager opens automatically.

You could save your macro project now with the
"Save as" command in the File menu with a new
name like Pants 1. You will keep the original project
and create a new file with editing in it. It will be always
good to have more then one saved file of your project.

CREATE A NEW STYLE OPTION
Highlight “Ladies Pants” in the Style Tree box, and then type a new style “Pants with Darts” in the Name” field:
Click the Add Style button.The new style "Pants with Darts" will be added under "Ladies Pants" in the Style tree
as a Style option.
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The “Styles” are the options that will be offered in the macro.  The “Active Style” field under the Style Name
indicates that the Styles you are naming right now will be derived from the Active Style called “Ladies Pants.”

Create another new Style called “Pants with Pleats.”

Type in the name field Pants with Pleats. 
Click the Add Style button.
The second style "Pants with Pleats" will be added
under "Ladies Pants" in the Style tree as another Style
option.

Select the Style Ladies Pants (it is bluelighted).
Click the Show button.
The Pants pattern window opens.

CREATE CUT LINES AND CUT
Leena doesn’t give us very extensive instructions for this alteration, but fortunately it is not a difficult one to do. The
first step says:

“Cut the front piece along the center line and from dart apex to the center of the leg cuff.”

We’ll need to create some lines for PatternMaker to cut with.    A cut line always has to start and end at a point
of the piece or outside the boundaries of the piece ( important with curves) it is cutting.  In other words, it has to
overlap the borders of the piece to be cut.  We will show you both ways in this tutorial.
For making the first cut line conveniently, there’s already a line down the pants’ center front.
The way to make the cut line outside the boundaries of the piece is simply to add a point at either end of the center
front line, outside the borders of the pants piece, and create a new object made up of those new points.
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Note: There are several options where to create the points and objects for cutting. If you add new points to the
parent style, here the Ladies Pants Style, these new points will be shown in all styles under Ladies Pants. It is
also possible to add new points and objects to a child's style. Then these points and objects are not visible in other
styles and the parent and can also not be used there. So consider before you add something what you want to do
with it and where it is best  to be added.
In this case for making the Pants with Pleats we are adding the points and objects, for making the cut, to the
parent style. 

ADD POINTS FOR FIRST CUT LINE

Create a new Coordinate point named Point 27.  
Its position will be relative to the point S, since S defines the center
front line.  Put the new point 5cm directly up from the point S (use Y
Fixed distance).

Point / Add / Coordinate

Name:  27
From:  S
Y Fixed Distance:  5

Create a point 5cm below Point 1 
(Y Measure, Fixed negative Distance).  
This will represent the end of the first cutting line:

Point / Add / Coordinate

Name:  28
From:  1
Y Fixed Distance:  -5

Tip: When you do not see the new point, click  the
Zoom All button and all points on the screen will be
shown.

NEW OBJECT: CUT LINE 1
Create a New Object called Cut line 1.  
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The object is simply a line, from Point 27 to Point 28. 
Note that we use the “open” point type when adding Point 28.  That means that this line is an “open” ob ject rather than a
“closed” one.  The end of the ob ject does not return back to the beginning of the ob ject.

Now your style window should look
something like the picture below. 
(For clarity in this illustration we have
turned off some points in the display –
Check the Hide boxes in the Point Edit
tab. )

Create an open line between 27 and 28

Object / Add / New

Name: Cut line 1

27 LM (on drawing screen)
28 LM

Do not check Closed

OK  (to save the new object)

Important: Whenever the Points form has been opened, you have to exit this tab by clicking Ok or

Cancel. If this is not done, a warning message will appear to Ok or Cancel the form.

SECOND CUT LINE
Now we need to create a cut line for the second pleat.  The instructions again:

“Cut… from dart apex to the center of the leg cuff.”

This will be from the dart apex (Point 11 in our drawing) to the center of the leg cuff (Point 1). We will now use
points for the cut line that are already part of the object.
We can use Point 1 in this case because Point 1 is placed on the center of the straight outside line 19-20 of the
pants. 
We can use also Point 12 as part of the cut line, extended from the dart apex, because it is also part of the piece
Pants. 

NEW OBJECT: CUT LINE 2
Create a new object called Cut line 2.  This line will begin at Point 12, go through the dart apex at Point 11, and
end to Point 1 .
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Create Cut line 2 between points 12, 11
and 1

Do not Close the object (uncheck the
Closed box).

Click OK to close the Object form.

Now your drawing shows the Pants Front
piece with the two cutting lines:

Again, Leena’s instructions:

“Cut the front piece along the center line...”

Now that we’ve drawn the cut lines, we’ll go to PatternMaker to do the actual cutting.
Save the project as Pants 1.mg4.  It is important to save always your work before launching PatternMaker and
going to the next step.

EDIT  MACRO IN PATTERNMAKER

Click the “Edit Macro“ icon on the File icon bar or select the Edit Macro in PatternMaker command from the File
menu
PatternMaker will open and automatically run the Ladies Pants macro.
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Select “Pants with Pleats” and click “Next.”

No measurements dialog box appears while running the
macro in PatternMaker! In the editing function that is
disabled.

Note: you are making a choice which style you want to edit.
The editing will be done in the style Pants with Pleats; this
means that the style Pants with darts and also the parent style
Ladies Pants will not be edited (they will stay original).
When you have made children in a style, you can not edit
the parent anymore!!

The drawing of the Pants with Pleats will appear on the screen in
PatternMaker.

PatternMaker does not have it's normal outlook. 
Only those commands, which can be used while editing, are visible in
the icon bar and menubar. This means that only a couple of commands
can be selected.(see further the Help section about Editing)

While editing the macro the drawing of the pants appears in
PatternMaker not in black but in green on the screen. 
Every piece in the Style tree will appear in its own color (like the colors
of the layers in PatternMaker).
The Pants piece is the second piece in the Style Tree (Base is the first
piece, Pants the second). Like the default colors of the layers in PM the
pieces in MG will appear in the same color scheme: piece 1 in black,
piece 2 in green, piece 3 in blue, piece 4 in red, etc. 
The different pieces are not drawn on a different layer like in PM, but
only in a different color. While editing the objects it can be handy to see
in which order the pieces are made in MG.
When you test the macro or run the macro in PatternMaker the objects
are always drawn at layer 0 or the current layer and in the color that is
set for that layer.

THE FIRST CUT
Use PatternMaker’s CUT command to cut the pants piece with the line called Cut line 1.  (The step-by-step
instructions are provided here.  However, we recommend that you review these commands in your PatternMaker
User’s Manual or Help file.)

Procedure:

1. Activate the CUT command by clicking on the Cut icon, or select “Cut” from the Edit menu.  The prompt on

the command line will say: Select object to cut: 

2. Click on the object you want to cut (the pants front piece).  It will highlight to indicate that it is selected.

3. When you have the correct object selected, click the right mouse (RM) button.  The command line will

say: Select object to cut with: 

4. Select the object that will form the cutting line (the line called “Cut line 1”).  This is like a cookie cutter, or

like the line the scissors follow when cutting the first object.
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5. After you select the object to be cut with, click the right mouse button (RM).  The Pants Front piece will be

cut by the cut line.  Nothing will appear to have changed in the drawing, because the objects do not move.
But PatternMaker says: Done

6. Close PatternMaker at the right top of the screen and do not save the file. 

You will return to MacroGen

RETURN TO MACROGEN
The change is made in the Pants with Pleats style, so be sure to have opened that style in MacroGen to see the
change. As you return to MacroGen, nothing appears to have changed.  As in PatternMaker, this is because the

pants piece is cut, but has not yet been moved.   
Open the Object tab.
After the cut in PatternMaker in the Pants with Pleats style
the Pants Front object has been replaced by Pants Front
(2) and Pants Front(3). 
(Note: in the other styles the Pants Front will still exist).
Use Hide to turn off one of the Front objects.  
Check the Hide box from the object called “Pants Front(2)”.
The object disappearing verifies that the cut worked.
Experiment with turning objects on and off.
In the Point tab/Edit you will see that new points are made
because of the cut in PatternMaker, Points Intersect and
Intersect(2), both Line - Line Intersection points.

You can change the names of the points
Intersect and Intersect(2) if you do not like
these names (for instance in point 29 and 30.
Just go to the Points tab. The Edit tab -
points list will open by default, open the point
and change the name in the point form.

Save your file again as Pants 2.mg4
after the first cut 
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THE SECOND CUT
Click the Edit Macro button to launch
PatternMaker again, select the style Pants
with Pleats again and cut the right Pants Front
with the Cut line 2.
Follow the procedure as described above for
the first cut line.

Close PatternMaker, do not save the file and
return back to MacroGen. In the style Pants
with Pleats in the Object tab you will see what
objects you’ve ended up with after the two
CUT procedures:
Pants Front(4), Pants Front(5) and  Pants
Front(3),
as well as the Cut lines 1 and 2 and the Zipper
facing.

The Pants Front(2) has been replaced by 4
and 5, a result of the second cut.
No new intersection points have been made,
because the points of the cut line already
existed.

Save your file as Pants 3.mg4

after the second cut

Note: 
Here in short a repetition of how MacroGen handles objects after editing and names them:

- When you connected points for the first time, you named the object “Pants Front”.

- In the style option Pant with Pleats this object was at first also "Pants Front".

- When you cut that front piece the first time, there was no longer one front piece, but two.  MacroGen
deleted the piece called “Pants Front” in the style Pants with Pleats and replaced it with “Pants Front
(3),” the half to the left, and “Pants Front(2),” the half to the right.

- After “Pants Front(2)” is cut, it is deleted and replaced by “Pants Front(4)” and “Pants Front(5).”
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DELETE EXTRA CUT LINES IN PATTERNMAKER
We no longer need the cut lines, so let’s delete them and clean up this
window a bit.  
Click the Edit Macro button to launch PatternMaker again and select the
style Pants with Pleats.
Click  the “Erase” icon on the Icon toolbar or click “Erase” on the Edit
menu: 
Select the two cut lines to erase and click RM. The two cut lines are
deleted.

Exit PatternMaker. 
You don't have to save the pattern in PM because there is a direct pipeline
between PatternMaker and MacroGen.

Note: 
You can also delete the cut lines in
MacroGen! 
(Tab Panel/Object/Edit/Delete)

Notice that the cut lines "Cut line1 and
Cut line 2 have disappeared from the
object list because you have erased
them in PatternMaker!

Save you file as Pants 4.mg4

Now that the pieces are cut, we need to rotate the pieces apart, making space for the pleats.  We’ll send the file to
PatternMaker again to accomplish that.

ROTATE PLEAT SECTIONS
Select Edit Macro to launch PatternMaker.  Select the Pants with Pleats option. 

The ROTATE command will ask what pieces are to be rotated, at what point they will be rotated around and how
much you want to rotate.

Procedure:
1. Activate the ROTATE command by clicking the Rotate icon, or select "Rotate" on the Edit menu.
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2. Select the object(s) to rotate by clicking the left mouse button on them.  In this case, select the two pants front
pieces at the right, Pants Front(4) and Pants Front(5).

3. To stop selecting objects, click the right mouse button (RM).  The prompt Rotate about what point? will

appear on the command line.
4. Turn on the “Snap To End Point” snap mode (<Ctrl>+<F3>)
5. Click on the point you want the pieces to rotate around – like the center of a clock.  This will be Point 1 (= or

Intersect), at the center of the pants’ cuff.  The prompt Rotation (angle or base point of
rotation)? will appear on the command line.

6. There are three ways to rotate something.  We’ll tell you here what method to use in this case, but we
recommend that you study the User’s Manual and/or Help file for details on the other methods.

Base point and distance: Click on the upper end of the cut line base point.  Type “-6” for the rotation distance

(minus = rotating clockwise) and press <Enter>.  The number represents either inches or centimeters,
depending on the Units you are working in.  PatternMaker calculates a rotation angle such that the selected
point moves the specified distance.

before rotating after the first rotation

Exit PatternMaker without saving changes.
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Back in MacroGen, notice how the two
cut pieces have been rotated.  This forms
the first pleat of the pants.

The point numbers (in parentheses)
indicate the number of times a point
occur in the drawing.  
For example, Point 11 is at first copied
into Point 11(2), Point 11 (3) is the
second copy of the original Point 11.

Save your file as Pants 5.mg4

Now the last step is to rotate only the far right front piece.

Launch PatternMaker (Edit Macro) and select the pleated option again.  

Activate the ROTATE command.  Following the instructions above, rotate the far right piece ( “Pants Front(5)”). The
point to rotate around is Point 1 at the bottom of the pants. The base point of rotation is the end of the dart at the
waist line, point 12(2).Type “-6” for the rotation distance (=clockwise) and press <Enter>.

Exit PatternMaker without saving changes.

Now both pleats have been rotated open.

Tip: If you only want to see the points on the screen that are used in the objects:
Go to the Point tab and click  the Hide All button. All Points on the screen are hidden. (see fig. 1)
Now go to the Objects tab and click  with your Right Mouse at the first object Pants Front(4).
A help menu opens. When you select Show All Points, all points that are used in all objects are
shown. The non-used points stay hidden.(see fig. 2)

If you only want to see the points in Pants front(4) select Show points
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Fig. 1 No points are shown Fig. 2 Only used points are shown

Save your file .
If you wish to add some lines to form cutting lines at the tops of the pleats, now is the time to do it.

Congratulations!  You’ve successfully transferred a macro to and from PatternMaker in order to make changes to
the pattern.  Your pants macro now has a darted option and a pleated option. Every time you edit in PM or test the
macro in PM a .mac file is made from your mg4 file which you can run in PatternMaker.

In the next tutorial, we’ll talk about how to give the user even more garment style options.

Note:
In this example you get a good idea how the editing works in PatternMaker/MacroGen4. You can do several steps at once
like cutting and rotate in one step, but we advise you to make not to many steps at once. When afterwards you did not want
to do one step you have to go all over again. When you save your project after every step, you save all the different stadia
of your editing.

Note:
After rotate new measures are made in the Measure list : Rotate Distance and Rotate Distance(2)
After rotate some new points are made in the Point list : 18(3) point type: Rotate Distance which uses the new measure
Rotate Distance(2)
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SEE ALSO THE MANUAL  FOR MORE INFORMATION ABOUT AUTOMATIC POINTS AND
MEASURES AFTER EDITING IN PATTERNMAKER!



Tutorial 

5
5. Adding Style Options
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5. Adding Style Options
One of the most useful features of PatternMaker’s macro system is the ability for the user to choose from among
various garment design options.  These can include neckline variations, sleeve styles, waistband treatments, or
anything else you want to offer.  This tutorial will take you through the steps of designing a macro that will prompt
the user for this kind of choice.

In this tutorial we will be following drafting instructions adapted from the book "Women and Children’s Garment
Designing", compiled by A. Gebbia and Master Designer, published by The Master Designer.   As in previous
lessons, you may find that the drafting method itself is not what you are accustomed to.  Remember that it is the
program we are teaching here, not drafting technique.  Once you are comfortable with the program, feel free to use
the drafting system that you prefer.

5.1 Drawing the sleeve

Open MacroGen and select Open Project. The folder Designers opens, then open the folder Tutorials MacroGen
and select the file Tutorials - Bodice.mg4.  This is a sample file included with the MacroGen installation.  
The Style Manager opens.
In the Piece List we have one piece
“Piece1”.  The original name "Base" that
appears when starting a new project has
been overwritten with Piece1.

To change the name, right-click on it in
the Style Tree window or in the Piece
List.
Type in “Bodice” for the new name and
click “OK” .
The new name appears in the Piece list,
and the piece is also renamed in the
Style Tree.

Changing the name of the piece does not change the Display Name (the name that occurs while running the macro
in PatternMaker). 
You also have to change the Display Name into Bodice if necessary. Place the cursor at the name and change it.
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We are going to add a sleeve, and it will have styling options which are different from the bodice.  That means we
need to create a new Piece for it in which we will draw the points and objects of the sleeve.  

In the Name field  type “Sleeve”, 
then click the “Add Piece” button.
The Piece Sleeve is  added to  the  Piece
list. 
After  adding  the  Sleeve  it  will  be
highlighted  in  the  Piece  List  at  the  left
and  therefore  also  showing  in  the  Style
Tree at the right of the Style Manager.

To open  the  drawing  area  of  the  Sleeve
click the Show button.
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The drawing area of the style option "Sleeve" opens.

When your drawing at the left is not zoomed well in the
drawing area, click the Zoom All button in your Status bar.
The drawing of the Bodice will be screen filling.

Note: the points and objects of the Bodice appear in b lue. This
indicates that they were created in another Piece window (in this
case, the Bodice).  They can be used in this Sleeve window as
references for new points, but they can’t be modified here.

UNITS
Before we get started, let’s make sure that the
Measurement Units are set correctly.  These
instructions use inches, not centimeters as in the
previous tutorials.  Click on the Settings menu and
see if there is a dot beside “Metric.”  If there is, click
on “Inches” to change the setting.
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ONE-PIECE FITTED SLEEVE
We need to add the Sleeve Inseam
measurement 
(Tab Measure/Add/Prompted
Measure).  

The instructions tell us this is 16 3/4".

In the Name field "New" appears in
blue. Change this into SleeveInseam
and enter also  the value (type 16.75).

Click the "Save" button 
and the measure is added and will
appear in the Measurements list at the
right side of the form.

Exit the form by clicking the OK
button.

We enter the points 1 - 26, using the tabbed panel as with the Hood tutorial.  
In the small charts, we’ll be using the following abbreviations:

SI       CW    
CCW 
 

= Sleeve Inseam
= Clockwise
= Counter-Clockwise

SOL 
EOL

= Start of line
= End of line

Note that we’re using the prefix “S” to indicate that these points are part of the sleeve pieces.  

SLEEVE PART I: DRAFT THE FRAME

We follow the instructions for the Sleeve as
mentioned above, described in the book we used
for this bodice. 
The drawings look like this:

“1 from A  is full Arm scye on 3rd division.”
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Coordinate (S1) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S1 A None 1 0 ArmScye -3 0

“2 from 1 is Sleeve Inseam.”

Coordinate (S2) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S2 S1 None 1 0 SI -1 0

“3 from 1 is center between 1 and 2 minus 3/4 inch.”

Center (S3a) Pt. Name From To

S3a S1 S2

Coordinate (S3) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S3 S3a None 1 0 None 1 0.75
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Note: Instead of adding point S3a and S3 you could have added only point S3  Coordinate, From S1, Y meas
SleeveInseam, Y scale -2, Y fixed 0.75

“4 is center between 1 and A .  Square backward off points 4, 1, 3, and 2.”

Center (S4) Pt. Name From To

S4 S1 A

We can’t draw these “squared-off” lines in MacroGen (unless we create more points and connect them with extra
lines), but a benefit of using MacroGen is that we know that the lines are represented by these points, without
having to do the extra work.
The drawing should now look like this:

SLEEVE PART II: ADD THE SLEEVE POINTS
“5 from 1 is full Armscye on 8th division plus 1/2 inch.  Square up a short distance toward 15.”

ArmScye will be the X Measurement, and the X Scale is “8.”

Coordinate (S5)
Pt. Name From X

Meas
X

Scale
X

Fixed
Y Meas Y

Scale
Y Fixed

S5 S1 ArmSc
ye

8 0.5 None 1 0

“6 from 5 is full Armscye on 1/2 division.”

Again, the X Measure is ArmScye.  The X Scale is 2 (armscye divided by 2).

Coordinate (S6) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S6 S5 ArmScye 2 0 None 1 0
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“7 from 6 is full Armscye on 8th division plus 1/4 inch.  Square down toward 9.”

Here we have an X Offset (0.25” ) used together with the X Measure (ArmScye) and X Scale ( “8” ).

Coordinate (S7) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S7 S6 ArmScye 8 0.25 None 1 0

“8 falls at intersection of elbow line.”

Point 8 is at the same X location (side-to-side) as Point S7, and the same Y location (up-and-down) as the elbow

line, represented by Point S3.  We can use the Rectangle point type in this circumstance.
Rectangle (S8) Pt. Name XCoord YCoord

S8 S7 S3

“9 falls at intersection of bottom line.”

Again, an intersection of a vertical line and a horizontal line means we can use Rectangle.

Rectangle (S9)
Pt. Name XCoord YCoord

S9 S7 S2

“10 from 9 is center between 2 and 9 plus 1/2 inch.”

We can accomplish point 10 in 2 ways. The first way is to use two points, the first point marks the center and the
second point is offset from that point like in point S3. Another way is to make a distance measure between S2 and
S9 (“Tab Measure/Add/ Distance” )and then a coordinate point using this measure with scale 2 and  an X fixed. 

Distance measure
 (S2-S9)

M. Name From To

S2-S9 S2 S9

Coordinate (S10)
Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S10 S9 S2-S9 -2 -0.5 None 1 0

Note that the point is calculated from S9, so X Scale and X fixed are minus (to the left).

“11 from 8 is same distance as 9 to 10.”

Again, an intersection of horizontal and vertical lines is a perfect condition for a Rectangle point.

Rectangle (S11) Pt. Name XCoord YCoord

S11 S10 S8

“12 falls at intersection of back notch line.”

Rectangle (S12) Pt. Name XCoord YCoord

S12 S11 S4

“13 is 3/8 inch above line A.”

Here’s another two-step process.  The Rectangle point S13a marks the intersection with the shoulder height line,
and then the Coordinate point S13 offsets the point 3/8” above that shoulder line.

Rectangle (S13a) Pt. Name XCoord YCoord

S13a S12 A

Coordinate (S13) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S13 S13a None 1 0 None 1 0.375



Tutorial 5. Adding Style Options 83

© 2003-2015 PatternMaker Software

“14 from 13 is full Arm scye on 8th division minus 1/4 inch.”

Point 14 needs to be placed on a line from A a certain distance from Point S13. This is a perfect situation for the
Line Distance command.  The point A defines one point of the line, for the second point of the line we have already
S13a. Then we place Point S14 on that line, measuring it from Point 13, Clockwise.

Line Distance (S14) Pt. Name SOL EOL From Meas Scale Fix.dist Dir

S14 A S13a S13 ArmScye 8 -0.25 CW

“15 from 5 is 1¼ inch”

Point S15 is directly above Point S5 (Y fixed distance).

Coordinate (S15) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S15 S5 None 1 0 None 1 1.25

Check the status of
your drawing:

“16 from 14 is 1/2 inch.  Shape run of sleeve head using points 13, 16, 15 and 1 as a guide.”

Point 16 is on the line defined by Point S12 and Point S14.  Begin at Point S12, head toward Point S14, then come

back toward 12 by the indicated amount (1/2 inch).  In other words, you tell the program
"Go from S12 to S14, and then back up half an inch (=minus)."

Continue (S16) Pt. Name Start End Meas Scale Dist

S16 S12 S14 None 0 -0.5

Note: Shaping of the run of the sleeve head by using the points as a guide has to be done different in MacroGen than
drafting the pattern by hand. Drawing a curve in PatternMaker is done by drawing an arc and using curve points. Making
those curve points we explain later on in this chapter. We have added those points to know over which points the sleeve

cap has to be drawn.

“17 from 13 is full Arm scye on 8th division plus 1/4 inch.”

Point S17 is the same situation as Point S14, except in the opposite direction (counter-clockwise, rather than
clockwise as with Point S14, so check the "C-Clockwise" box ).
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Line Distance (S17) Pt. Name SOL EOL From Meas Scale Dist Dir

S17 A S13a S13 ArmScye 8 0.25 CCW

“18 is center between 6 and 7. Connect 11 with 18 and continue line toward 20.”

Center (S18) Pt. Name From To

S18 S6 S7

“19 falls on Line 4.”

Point 19 is the intersection point between the lines S4-S12 and S17-S18, therefore a Line Line intersect. A Line
Line intersect point can also be placed outside the lines. 
Line Line Intersect
(S19)

Pt. Name 1 Start 1 End 2 Start 2 End

S19 S4 S12 S17 S18

“20 from 18 is 1/2 inch.”

Continue (S20)
Pt. Name Start End Meas Scale Dist

S20 S11 S18 None 1 0.5

At this point, the drawing should look like
this:

“21 from 17 is 1/2 inch.  Shape cap of sleeve using points 7, 20, 19, 21 and 13 as a guide.”

Here, Point S21 is on a line defined by the pre-existing points S12 and S17.

Continue (S21) Pt. Name Start End Meas Scale Dist

S21 S12 S17 None 1 -0.5

Note: Shaping the cap of the sleeve by using the points as a guide has to be done different in MacroGen than drafting the
pattern by hand. Drawing a curve in PatternMaker is done by drawing an arc and using curve points. Making those curve
points we explain later on in this chapter. We have added those points to know over which points the sleeve cap has to be
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drawn.

“22 from 3 is 3/4 inch.”

Coordinate (S22) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S22 S3 None 1 0.75 None 1 0

“23 falls at intersection of bottom line.”

Use Line Line Intersect in this case rather than Rectangle because the lines are not perfectly vertical and
horizontal.
Line Line Intersect
(S23)

Pt. Name 1 Start 1 End 2 Start 2 End

S23 S1 S22 S2 S9

“24 is center between 23 and 10.”

Centre (S24) P. Name From To

S24 S23 S10

 “25 from 10 equals same distance as 10 to 24, plus 1 inch.”

Create a Distance measure S10-S24 (“Tab Measure/Add/ Distance” ), then use it as the X Measurement for Point
S25. Remember to include the 1-inch X Offset.

Distance measure 
(S10-S24)

M. Name From To

S10-S24 S10 S24

Coordinate (S25)
Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S25 S10 S10-S24 1 1 None 1 0

“26 from 8 is 3/4 inch.”

Coordinate (S26) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

S26 S8 None 1 -0.75 None 1 0

“Connect 26 with 25 and continue line toward 27.  Lay long arm of square on 26-25 line, with
short arm resting on 10 and square back toward 27.”

This tells us that Point S27 is to be the corner of a right angle.
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“27 falls at intersection of 26-25 line and line 10-27.”
The original instructions for point 27 are confusing.  Defining Point S27 as an intersection of itself doesn’t make
sense.  Use the Line Point point type instead of Line Line Intersect.  This command does exactly what we need:
putting a point at a right angle between a line (S26-S25) and an existing point (S10).

Line Point (S27)
Pt. Name SOL EOL Leg

S27 S26 S25 S10

Now that the points are entered for the shape of the
sleeve,
the drawing looks like this:

ELBOW DART
“28 is center between 11 and 26.”

Center (S28) Pt. Name From To

S28 S11 S26

Tip:type in the from Field S11 to be able to select this point fast. 

“29 from 26 is same distance as 22 to 23 on front sleeve inseam.”

Create a Distance measure S22-S23.  Then use it as the measurement for Point S29.
Distance measure
(S22-S23)

M. Name From To

S22-S23 S22 S23

Continue (S29)
Pt. Name Start End Meas Scale Dist

S29 S25 S26 S22-S23 -1 0

“30 from 26 is same as 27 to 29, minus 3/8 inch

Create a Distance measure S27-S29, and use it as the Measurement for Point S30.

Distance measure

(S27-S29)

M. Name From To

S27-S29 S27 S29
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Continue (S30) Pt. Name Start End Meas Scale Dist

S30 S29 S26 S27-S29 -1 0.375

Note: the fixed distance is a positive number, because the distance S30-S26 is 3/8 inch smaller as S27-S29
To check if S30 is set right you can add a new distance measure S30-S26

“31 from 28 is same length as 26 to 28.”

Create a Distance measure S26-S28 and use it as the Measurement for Point S31.

Distance measure
(S26-S28)

M. Name From To

S26-S28 S26 S28

Continue (S31) Pt. Name Start End Meas Scale Dist

S31 S30 S28 S26-S28 -1 0

THE CURVES OF THE SLEEVE CAP
The instructions stop here, but there are more points we need to add in our project to make the curves of the sleeve
right.  By hand you draw the curves of the sleeve cap going through the added points. But in MacroGen we have to
add the corner points at the right place in the pattern and where these corner points need to be placed is not
defined in the instructions of the pattern.
There are many ways you can make those curves, it is a matter of how you want to have a sleeve cap drawn
(fluently and smooth), of how many curves does it exist and whether you can find the right formulas for placing the
curve points at the right place. 
The programmed points 16, 21 and 20 can be helpful to test if your curve points are at the right place and if the
sleeve cap is going through these points. You can always test everything in PatternMaker to see what you drawing
looks like and if you are satisfied. 

Note that the pattern making descriptions belonging to your pattern drafting system are always an estimate of through
which point the drawing needs to be drawn. To get really smooth fluently going curves it is often necessary to move the
point a little bit up, down or to the left or right. It is therefore really important to understand the way curves need to be drawn
in PatternMaker to be able to make them in MacroGen.

In this case we add test lines (objects) of the drawn points 16, 21 and 20 to our project. When we test our macro in
PatternMaker we can see if our sleeve cap is nearing those test lines.
The best way is making test objects and test the macro in PatternMaker to see if the drawing looks like you
wanted it to be.

At the top center of the sleeve cap we see that the
sleeve outline goes through Point S13. We divide
the sleeve cap in two pieces,  the front cap and the
back cap with point S13 at the top.
At the front we see in the picture of the sleeve cap a
curve (an arc) going from point 1 to point 15. After
that we see a curve from 15 - 16 and from 16 to 13. 
This means 3 curves in a row. The more curves you
have in an object the more difficult it is to get it
smooth and fluently. Therefore in this case we will
make 2 curves at the front :
- from point 1 -corner(curve) point- point 15  
- from point 15 -corner(curve) point- point 13 (going
through point 16).
At the back we see a curve from 7 - 19 through 20
and from 19 - 21 and from 21 - 13. 
This means also 3 curves in a row. In this case we
will make 2 curves at the back:
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- from point 7 -corner point- point 19
- from 19 -corner point- point 13 (going through point
21).

We start with the corner points at the top of the cap. To have a smooth cap head two corner points at the top need
to be placed at the same height as point 13, a horizontal line from 13. 
A corner point for the front sleeve at the left of 13 and for the
back sleeve at the right of 13.
To have two curves fluently going over in each other we can use
example 3 in chapter 2: Planning a curve  although the two
curves here look different, but the system of the corner point-
endpoint-corner point in one line is the same.
The question is where should the corner points be placed?
For the front we add a rectangle point 32 with the X of 15 and
the Y of 13. The corner point needs to be placed between 13
and 32. 

Rectangle (S32) Pt. Name XCoord YCoord

S32 S15 S13

To know where the corner point needs to be you could test this in PatternMaker but then you need to make objects
form the sleeve points.
Exercise learns that often this corner point is placed at 1/3 of the line 32-13.
This means that a Distance measure has to be made,before you can add this corner point using the distance
measure.

Distance measure
(S32-S13)

M. Name From To

S32-S13 S32 S13

We can make the corner point G (since Points A through F were used for corner points in the bodice),
again adding the “S” prefix to indicate that it belongs to the sleeve).

Coordinate (SG) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

SG S32 S32-S13 3 0 None 1 0

For the front cap we need to add the corner point  between the
points 1 and 15. 
To have two curves fluently drawn example 3 in chapter 2:
Planning a curve  can be used. The corner point SG - Point
S15 and the new corner point are at one line (green cross-b lue

cross- green cross).
To get this new corner point SH a Line Line Intersect between
the points SG - S15 and S1 and S5 is made. In a Line Line
Intersect the intersection point can also be placed outside the
line.

Line Line Intersect
(SH)

Pt. Name 1 Start 1 End 2 Start 2 End

SH SG S15 S1 S5

For the back we add a rectangle point 33 with the X of 19 and the Y of 13. The corner point needs to be placed
between 13 and 33. 

24

24
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Rectangle (S332) Pt. Name XCoord YCoord

S33 S19 S13

We do here the same as at the front: the corner point is placed at 1/3 of the line 33-13.
This means that a Distance measure has to be made,before you can add this corner point using the distance
measure.
Distance measure
(S33-S13)

M. Name From To

S33-S13 S33 S13

Now we can make the corner point SI. 

Coordinate (SI) Pt. Name From X Meas X Scale X Fixed Y Meas Y Scale Y Fixed

SI S33 S33-S13 3 0 None 1 0

For the back cap we need to add the corner point between the points 7 and 19. 
Using point 18 for that as a corner point will not give a fluently drawn curve, because the points GI -19 - 18 will not
be on one straight line
We make another Line Line Intersect between the points SI - S19 and S7 - S6. 

Line Line Intersect
(SJ)

Pt. Name 1 Start 1 End 2 Start 2 End

SJ SI S19 S7 S6

The current drawing with all points added:
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CREATE SLEEVE OBJECT

(Note: before you begin connecting points, you may wish to hide
the points not used to create the sleeve.  To do this, select Point
and Display/Edit from the tabbed panel, and hide ONLY the points
in the list below by checking the boxes next to them.  Then,
beginning at the top of the point list and going straight down, click
each box -- this will hide all of the points you don't need to see,
and show all of the ones that you DO.)

Here, only the points used in connecting the object are
shown:

Now we can add the new object Sleeve.
Using the panel, select the tab Object/Add, and click the "
New" button. 
In the Object Name box, type "Sleeve".  Connect the points
by clicking on them in the following order
Remember that you need to LEFT-click  on a coordinate 
before you can right-click  to change it to XArc Start (X) or
XArc Corner (C) 

S1 X 
SH C
S15 X
SG C
S13 X
SI C
S19 X
SJ C
S7 L
S26 L
S28 L
S31 L
S27 X
S10 C
S24 L
S23 L
S22 L

Put a check in the "Closed" box,
and click OK.
The Sleeve object is saved now.

To check if the sleeve cap is going over the original drawn points S16 and S21 we make a test  line of them. When
we test the macro in PatternMaker we can see the result.
At first before we can add that test line we have to make the points visible. So select the Point tab and make the
points S12, S16 and S21 visible by unchecking the Hide checkbox.
Then select the tab Object  Add, and click the "New" button. 
In the Object Name box, type "Test line".  Connect the points by clicking on them in the following order:
S16 L- S12 L- S21L   and leave the object open.
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Click OK to save the Test line.

Now we can test the macro in PatternMaker to see if the sleeve cap is drawn all right, so click the Test Macro
button and PatternMaker will be launched. 
The drawing of the sleeve is shown at the right side. 
The sleeve cap is going nicely over the Test line with the points 16 and 21. This means that our formulas where to
place the corner points were right. You could also test if this is going well with other measurements.
To see if the sleeve cap is also drawn right over point S18 you could make another test line for it.

If you don’t like the shape of this sleeve, you can change the position of some points if you wish.  However, keep in
mind that this is simply an exercise in MacroGen commands, not pattern drafting technique.  When you use your
own drafting system, sleeves and all other pieces will look much more familiar to you.
When you are satisfied with the form of your sleeve you can delete the test lines. You do not want them further
appearing in your macro or drawing.

We have two different Pieces – Bodice and Sleeve – we are going to add styling modifications to them.
Close this editing window and go back to the Style Manager.
Save your new file with the name “BodiceWithSleeve.mg4"  (use Save as)
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5.2 Style Options

ADD NECKLINE STYLES
Make sure that “Bodice” is selected in the Piece List, then
click “Bodice” in the Style Tree.

Type “Jewel Neck” in the Name field.
Click the “Add Style” button under the Style Tree window.

The new style “Jewel Neck” appears indented under “Bodice”
in the Style Tree.  This indicates that the Jewel Neck is a
“variation” or an “option” of the basic bodice.

Highlight “Bodice” again on the Style Tree and then type “V-
Neck” in Name field.
Click the “Add Style” button.

Now there are two “variations” for the bodice: Jewel Neck and
V-Neck.  These are the options that will appear in a dialog box
when the macro is run.

Save the macro as BodiceWithSleeve_1.mg4

MODIFY NECKLINE STYLES
Since the original basic bodice already had a jewel neck, the Jewel Neck variation doesn’t need to be changed. 
We do need to modify the V-Neck, however.  We will do this by editing some existing points and adding some new
ones in the V-Neck Piece window.
Click “V-Neck” in the Style Tree and "Show" to open the Piece window.  Notice how the variation automatically
inherits all the points contained in the “parent” piece (in this case, the Bodice).
In this piece the points of the sleeve are not visible because they are created in a later piece.
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We can change the neck line into a V-neck line by moving point 28 a couple of cm down and then by changing
point E to be the center of points 27 and 28.  If these three points are all in a line, the curve will become a line.  We
could also modify the object itself to get the same result (changing the object by deleting point E from the object,
then we have a straight line between 28 and 27), but we will save that method for later, when we create some
sleeve styles.

From the panel, select Point and Edit, highlight point 28 and
click the "Edit" button or double click at point 28.
Since you are modifying ONLY for the V-Neck style, uncheck
the "Use Parent" box.

Now you can edit the values of point 28. For the V-Neck we
lower  the neckline 2", otherwise it will be too tight . This
means that the Y Fixed distance is set to -2 (minus is down).

Then we edit point E, highlight point E and click the "Edit"
button or double click at point E.
Since you are modifying ONLY for the V-Neck style, uncheck
the "Use Parent" box.
Click the  "Change" button.

Select Center from the Change Point Method form.

The Center form opens. 
Make sure "Use Parent" is unchecked (This is important,
otherwise you can not change the values!).

MacroGen has filled in already some points that were used in
the former point E . Check if these points are right
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Click OK

Now Point 28 is lowered and point E is in the middle of Point
27 and Point 28.

We can get a better view of the object by turning off the points
(or, more accurately, the number label at each point).

Using the panel, select the Point and Edit tabs. 
A check mark in the box next to a point will hide that point,
and an unchecked box leaves the point visible.  
You can also "Hide All" or "Hide None".
We want to turn all the points off to get a good look at our
drawing, so click "Hide All".

With the point labels out of the way, it is clear we have a V-
Neck.  Neat, isn’t it?

  Now save your work again by clicking the Save icon from the File Toolbar or use the Save as command in
the file menu and give it a different name (e.g. BodiceWithSleeve2.mg4).

 Then select the “Create Macro” icon from the File Toolbar.  Nothing will appear to happen, but the macro has
been created!  Remember, MacroGen automatically gives the macro the same name as your MG4 file that you just
saved and saves it in the same folder.
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Now let’s try running the macro and see what happens.

 Select "the “Test Macro" icon from the File Toolbar or select the “Test Macro” from the File menu. 

PatternMaker opens and we see the first Style option form.
The title of this  dialog box (Bodice)  comes  from  the  piece  name,
and  the  listed  options  are  the  variation  names  (Jewel  Neck,  V-
Neck).  If we want to change the appearance of this dialog box,  we
change the corresponding options  in  MacroGen.    (See  the  Help
file under “Macro dialog box captions” for a detailed diagram.)

A couple of issues come up and are worth mentioning at this point. 
First of all, we can never select the Bodice style (in this particular file) in PatternMaker, only Jewel Neck and V-
Neck.  The following rule applies: if you descend (create from your master pattern) a “child” style, you lose that
original style option in the PatternMaker dialog box. This isn’t a problem because the child is always a duplicate of
its parent (at least until you change it).
In the case of the Bodice macro, the Jewel Neck style (child) is identical to the parent, since you have changed
nothing.
If you use PatternMaker to modify an object (Edit Macro), it keeps track of which piece style you’re modifying and
applies the changes to that style only.  For example, if we had run PatternMaker, selected Jewel Neck and
changed it, those changes would show up in the Jewel Neck style in MacroGen, but not in the Bodice style or the
V-neck style.  Once a “style variation” is added (i.e. the Jewel Neck version), the “parent style” (the Bodice) can no
longer be modified in PatternMaker.

Cancel the macro and close PatternMaker without saving. 

ADD & MODIFY SLEEVE STYLES
Now we are going to add the short sleeve option to the sleeve.

First save the macro as BodiceWithSleeve3.mg4.
Go to the Style Manager.

Under Piece List highlight “Sleeve.”
Under Style Tree select “Sleeve.”
In the Name field type “Long Sleeve” and click “Add Style.”

Under Style Tree select “Sleeve.”
In the Name field type “Short Sleeve” and click “Add Style.”

You’ve now added two variations to the Sleeve. You should see the
following:

Double click on “Short Sleeve” under the Style Tree (or highlight
“Short Sleeve” and click the “Show/Hide” button) to display the
Short Sleeve editing window.
To create a short sleeve we need to add a few new points.  Let’s prefix them with SS for Short Sleeve. 
Select the Point tab in the panel and add the following points: 

Center (SS1) Pt. Name From To

SS1 S1 S22
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Note: You can select the points by scrolling the arrow cursor. It is faster by typing th name of the point in the name field.

Center (SS2) Pt. Name From To

SS2 S7 S26

From the panel, select Object and Edit.  
The Sleeve object is highlighted (it is the only object in the list).
Double click the Sleeve object in the list to open it for editing or
click the "Edit" button at the bottom.

In the list after point S7 one by one double click all points (opens the Connection box of the point)  and delete them
(S26, S28, S31, S27, S10, S24, S23 and S22).  (It looks a bit strange as the points disappear.)  
Click OK.
Note: You can also click left on a point on the screen to open the connection box.

Now, we need to add the short sleeve points to the object. 
Open the Sleeve object again to edit it. (Double click the Sleeve object in the list or click the "Edit" button).

We need to add the points SS1 and SS2 after point 7, which is the last in the list. This means we do not need to
insert a point, but can easily add it. When we click at point SS2 on the screen it will be be added automatically to
the list after the last point 7.
Then click at point SS1 on the screen and it will be added to the sleeve after SS2. 
The short sleeve is finished.
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Note: When you added by accident first point SS1, it was necessary to
insert point SS2 after point S7. 
Click on point S7 and right-click to open the Connection box. Then
select Insert. Click at SS2 on the screen.

Always click OK after finishing an object

We have finished editing the Short Sleeve.
Notice the picture has the new short sleeve, and
the jewel neck with it.

Save the project as BodiceWithSleeve3.mg4

We’ll view the pattern with the V-neck variation.

SELECTING THE “ACTIVE STYLE”
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This is important if you had a previous style that changed the location of points (like centering point E with the V-
neck) and the current style uses that previous point.
You can view various combinations of options by selecting the variation you want in the Active Style drop-down list
for each piece. By default MacroGen will always select the parent style as "active style".

With the principles covered in the first four tutorials, together with the Help file, you’ll be able to go a long way
toward creating your very own macros that will work with PatternMaker.

In Tutorial 6, we will briefly cover some pattern marking features on the Connect Points form that you may have
noticed earlier.



Tutorial 

6
6. Pattern Markings
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6. Pattern Markings
This lesson covers some of the details that make a macro pattern a little easier to use.  Notches, labels on the
pattern pieces, and seam allowances all give the user an advantage when they are sewing the garment together.

6.1 Notch

Now that we have created a pattern with two styles we want to add some detailing.  First we will add a notch to the
sleeve.  

Open the file we created in the last lesson (BodiceWithSleeve3.mg4), and make sure  you have "Inches"
selected from the Settings menu.
In the Style Manager select “Sleeve” from the Piece list and double-click on “Long Sleeve” under the Style Tree
to display the Long Sleeve pattern window (or select Long Sleeve and click the Show button).
Select the Object Tab and the Sub Tab Edit.
Double click the Sleeve object in the list to open it or select the Sleeve and click the Edit button. 
The list of points of the Sleeve object appears.
From the list, double-click "S22(Line)". 
The Connection box opens. Under Notch from the drop-down list select "Notch". 
Click OK 

When “Notch” is selected, the point that was selected in the Points list – “S22[Line]” – changes to “S22[Line]
Notch.
This indicates that we have created a notch point where point S22 is.  This corresponds to the level of the elbow
dart.  We can’t see the notch when the sleeve is drawn in MacroGen.  The only place the notch is indicated is in
the Points list of the object.  If we launch PatternMaker we will see that the notch points inward.  The only way to
check the notch direction is by running PatternMaker.

To reverse the notch, put a check in the “Notch Direction” check box.  When this box is checked, S22(L)Notch
changes to S22[Line]Notch*.
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The letter inside the
[ ] indicates what
type of notch we
have:
N=normal
D=double
T=tab
W=wide tab
B=button hole.

An asterisk (*)
indicates the
direction of the notch
is reversed.

 

N 
 
D 
 

T 
 

W 
 

B 

Save the project as BodiceWithSleeve4.

6.2 Offset

Next we will add a ½" offset (seam allowance) to the sleeve. We will add it to the Long Sleeve style.

From the panel, select the Object tab and then Edit.
Open the Sleeve by double clicking at it or select Sleeve and click the Edit button.
Then click the "Advanced" button at the right top.
Type “0.5” in the Value field. (we set an default offset of 0.5) and click OK.

Note :  when you fill in anything in the measure or Value field of the Offset the arrange box will get checked automatically.
See Arrange the patterns  for more information.

Back in the Sleeve object click “OK” to save the changes to Advanced.

Once again, the offset doesn’t show up anywhere except running the macro in PatternMaker.  The object and its
offset (seam allowance) are automatically grouped together in PatternMaker.
When you test PM and select the Long Sleeve you will see the drawn seam allowance.

If you want also an offset for the Short Sleeve style, you have to add the Offset in that style to the Sleeve object.

We have made an offset of 1/2" which is always automatically drawn. When you want the user have a choice in an
offset and how much instead of filling in value field with 0.5 you can make a prompted measure Seam allowance

110
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which is selected in the Measure field in the Advanced box.
In PatternMaker a prompted measure Seam allowance is showing to fill in.

IMPORTANT!
At the moment when you you add an offset to a parent style which has children MacroGen will give
you a warning message after you to clicked OK to save the change to the object. 
- Selecting "Change Children" will reset all children to the changed parent.
- Selecting "Keep children" will only make the change to the parent.
This means that it is not possible to add the offset to parent and children at once without resetting
the children back to the parent. 

Save your project.
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6.3 Text

Next we want to add some text to the pattern.

Select the “Text”sub tab from the Object tab and click "New".

Name:  Text 1

Text:  Long Sleeve

Height:  1

Angle:  90

Click on Point in the drawing area:  S11 
S11 will appear in the Point for Text field
The offset form opens.
Fill in a Fixed Distance of 2 in the Y Offset box.

Moving the cursor over S11 in the Point for Text field will show:
- the X and Y offsets in the Status bar or
- the X and Y Offsets in a little rectangle connected to the cursor

The added text is drawn into the sleeve piece.  (You can always increase the text size if you wish)
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Save your project.
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6.4 Grouping

If we moved the sleeve in PatternMaker, the text wouldn’t move with it.  We need to group the two objects together.

From the panel, select Object and Edit.
Highlight the Sleeve object and click "Edit."

Here is where you create the Sleeve Group that will allow you to
combine the Long Sleeve with its text label in the following
steps.

In the “Group” field overwrite (None) with the name of the
group, “Sleeve Group.”
Click “OK.”

This creates a group named “Sleeve Group” and places the
Long Sleeve Piece into it. 
When you click the arrow of the drop-down list you will see that
the group Sleeve group is added to the list and another (None)
appears again.

Next, making sure the Object and Edit tabs are
still selected, highlight "Text 1" and click "Edit".
Select the "Sleeve Group" option from the drop-
down list to add the object "Text 1" to the Sleeve
Group.  
Click OK.  
(you always have to confirm your changes to an
object!!

Now, when you test the macro in PM and move
your sleeve piece, the text will move with it since
those two objects have been grouped together.

  Save your project!
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6.5 View the pattern

Now take a look at all the markings you’ve added. 
Save your macro and select the “Test Macro” icon from the Status bar. 

When the dialog boxes appear, choose either neckline, but then be sure to choose the Long Sleeve option. 
Accept the default measurements, and the pattern will appear on the screen.  Notice the seam allowance, the
notch, and the text object.  Check if everything is correct. 

Now, let’s test the Grouping feature.

Click the “Move” icon on the icon bar. 

Left-click on the outline of the sleeve.  It will be highlighted.  (Notice how the text also gets highlighted.)  Right-click
to indicate that you’re finished selecting things.
Left-click on the outline of the sleeve again.  You are selecting a base point, or “handle” for the Move operation.

Move the mouse a bit to the right, then left-click again to “drop” the objects.  The sleeve, the seam allowance, and
the text all remain together.

Close PatternMaker and do not save changes.

6.6 Arrange the patterns

While testing the macro in PatternMaker you noticed that the Long Sleeve with its offset and the Back Piece
(without offset) were overlapping each other.

Overlapping pattern pieces can be confusing for the user, it is difficult for a non-advanced sewer to know exactly
how the pattern pieces have to be cut.
In MacroGen the Arrange feature can handle this problem and will ensure that pattern pieces do not overlap on the
screen.

To have the Arrange command working you need to do two things:
Important is that in each main object ( the outside lines of a pattern piece) has to have the Arrange box checked
under the Advanced button in the Object tab. It is not necessary to have an offset filled in. MacroGen will
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automatically check the arrange box when you fill in an offset.
In each group only one object can have the Arrange box checked, this is the object that will have the offset drawn
around it.
In the Sleeve group this means the Sleeve object will have a checked Arrange box, the text object will not have it
checked or eg a grain line.
In the Settings menu the Auto Arrange command should also be checked.

Test the Arrange command with your BodiceWithSleeve project. 
Check the Arrange boxes in the Bodice front and back part, you can also fill in an Offset of 0.5". 
Check the Auto Arrange command in the Settings menu. 
Then create a macro and test it in PatternMaker.
See if the Arrange command is working and no parts are overlapping.

Note: It is always possib le to program your the points in ob jects in a way that the parts will never overlap. Add points to an
object so the ob jects will be placed further away from each other.
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7. Creating Commercial Files
This lesson covers some features of MacroGen that you can utilize to give your macro distributions a professional
touch.  You can give your users a head-start by providing a set of “standardized” measurement tables and offer the
macros in your customers’ own language.

For producing a sleek Windows-compatible installation file for distribution you will need the separate program
Collection Creator, also made by PatternMaker Software.

7.1 Measurement Table

NOTE: We’ll be returning to the hood we created in Tutorial 1, so the first thing we need to do is change back to
metric units.  (Don’t open the hood project just yet.)  Select “Metric” from the Settings menu.

There are two types of measurement tables used in PatternMaker: 

.MMT (master measurement table)

.MTB (personal measurement table

The .MMT file is the “template” that you distribute with the macro.  It lists all the measurements that are required
for your design(s).  A user will open this .MMT file, replace the default numbers with her own, and then save the
list.  When the list is saved, it automatically becomes an .MTB file.  The user cannot accidentally erase the original
.MMT file.

The personal measurement tables (.MTB) are created through PatternMaker.  We’ll see how in a minute.  But in
order for a user to create an .MTB file, you must supply an .MMT file.   MacroGen helps you create this file.

CREATE AND SAVE A MEASUREMENT TABLE
At first in an empty project we make a simple measurement table and afterwards we are going to import it into our
Hood project. Creating the first table could also be done when you are making a macro.

Open MacroGen and begin a new project.
In the Style Manager, type “Test MeasTable” for the Macro Title.  Type “Piece 1” for the first Piece Name, and
click the “Add Piece” button.
Open the editing window for the piece called "Piece 1” with the Show button.
Click the tab Measure from the panel. Then click the sub tab Add.
Select "Prompted Measure”.
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Add the Following Measurements:

Click the New button at the left bottom before
every new measurement you want to add.
Click the Save button to save your input after
every added measure.

Neck:  33.5 (remember, we’re working in
centimeters)
Height:  40
Body Height:168 (can be anything)
Bust Circ.: 96 (can be anything)

Notice when you click New, a measure "New" is
added to the list at the right. 
After clicking "Save" the name is overwritten with the
typed name.

You can always open this Prompted measurements
form by clicking the button "Table" in the Measure
panel

When all your prompted measurements have been added, the
measurement table can be made.

Click first the New button at the right bottom of the form.  You can
create a new measurement table.
Fill in the name of the table in the table name field.
Make sure to make your Table name unique and clear for which
macro's it can be used (for instance Leena_women or Leena_men 
says it is from the designer Leena and for whom, women or men, it
is used).
In this case enter “Master_Test Table” as your Table name.
Check the measurements Neck, Height and Body Height in the
list. 
The Bust circ. we do not want right now in this Master
Measurement Table. 
Click “Save” to save this table. It is now saved in the folder
Personal Files/MeasureTables with the name Master_Test Table.
mmt to be able to test the table. 

When you save a table MacroGen will show a message  to let you
know that your table is locked to prevent from accidentally changing
it. 
When you want to change the table after having saved it, you have to
uncheck the Lock box . 
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ADD PICTURE AND DESCRIPTION 
The names of the measures and the default values are saved to the table.
We also want to save a picture and a measure description to the measures which will be showing in PatternMaker.

Uncheck first the Lock box in the Measurement table field. A warning message will appear that changing the
measure table could cause problems with already made macro's (for instance when you change the name of a
measurement).
Then select the measure "Neck" in the measurements list, click on the rectangle under the Picture Field at the
left and scroll for "Hood Width.jpg". 
The pictures for these measures can be found in the Tutorials folder: My Documents/PatternMaker/Personal
Files/Designer/Tutorials.
Select the right picture and click the "Open" button. The picture will appear in the picture field.
In the Picture Description field, enter the description "Hood Width Measurement".
Click the button "Save" at the left to save your changes to the measurement.
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Next, highlight "Height" and click on the Picture Field to scroll and select "Hood Height.jpg."  
Type "Hood Height Measurement" in the Picture Description box.
Save the measurement at the left.  
Then save the measurement table with all the changes with the "Save" button at the right bottom.
The measurement table Master_Test Table is saved in the folder MeasureTables.
The picture and description files (.jpg and .txt) are saved in the MeasurePictures folder (the .jpg picture is copied
to it).

Notice: to the Body Height measure we did not add a picture or text description. These files are therefore not made in the
MeasurePictures folder.

Click OK to exit the Measurement Table form. 
Then save your project file.

MODIFY THE HOOD MACRO
We are going to import the Master_Test Table.mmt into the Hood macro we made in Tutorial 1.

Open the project file from Tutorial 1, the Hood.
Open the style Hood with the "Show" button to go to the pattern area.
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Select the Tab Measure and click the Table button at the bottom. The Prompted Measurements form opens
Notice in the Measurements List the two default measurements we created, “Neck” and “Height.”  

Click the “Import" button.

The folder MeasureTables opens. Select the .mmt file called “Master_Test Table” and click the “Open” button.  

The table is imported in the Hood macro. The Neck and Height measurements that we put in our .MMT template
file are checked, also the Body Height measure is showing in the list and the imported Master_Test Table .mmt
is showing at the right bottom in the Measurement Table field of the form.

If you run PatternMaker you'll notice that the hood doesn't ask for Body Height.  This is because this measure is
not used in this macro.  You can leave prompted measurements in the macro even if they aren't used.  This is
helpful because in the future you may alter this macro so that it does need one of those body measurements.

Note:
When designing a macro, you also have the option of importing your master measurement tab le BEFORE 
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you begin adding measurements or points. Then you are sure to have all the right measure names.

Let’s look at how measurement tables are used in PatternMaker when a macro is run:
After a macro finishes displaying all the style dialog boxes, it will show an “Open File” dialog box.  This is where
the user can select a personal measurement table (.MTB) if she has created one.  If no measurement file is
selected (if the “Skip” button is clicked) the macro will display another dialog box which asks for the
measurements.

If a measurement table is selected, the macro will extract the necessary measurements from the table.  If
conditional measurements are used in the macro, or if additional measurements are used by the macro which are
not in the table, the user will be prompted for those separately.

CREATING AN .MTB FILE IN PATTERNMAKER
In case you’re not familiar with creating personal measurement tables in PatternMaker, here’s how it works:

Open PatternMaker.  Select “Create Measurements” from the Settings menu.  An “Open File” dialog box opens.
Select the .MMT file you want to use and click the “Open” button.
A form opens with two columns: a measurement name, and a default value.  For each measurement, replace the
default number with your own.
Enter your name or some other descriptive information in the field labeled “Measurement Table For:”
Click the “Save” button.  Give the file a name and save it.

Note that since an .MTB file is created from a specific .MMT file, any particular .MTB file can only be used in macros which
are based on the same MMT file.  The macro contains information about which .MMT file is expected.  If the information in
the user’s measurement tab le does not match the information in the macro, the .MTB file will not be displayed.  This is a
safeguard to prevent a user from running your macro with, for example, measurements from Donna Designer’s
Measurement System.

7.2 Language Translation

Language Translation is a feature you can use to produce your macro in different languages. 

Note:
PatternMaker Software does not provide translation services.  This feature is included simply as an
added benefit to designers who are multi-lingual.

Open the saved “Hood.mg4” macro project file.
Before we add language translation to the file we add/change some things to the project to clarify the way
Language Translation works.
The Macro Title we change into Hood Collection.
The Style hood we change into Hood Style (do not forget to change the Display Name).
We add a Text object named T_Hood, which belongs to the groupe G_Hood with the Text HOOD (Point for text E,
X offset 4).
Save your project as Hood +translation.mg4

Select “Language Translation” from the Settings menu.

A Language translation form opens.
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In the grid we see eight columns, one for each language.  

The first column on the left is your Base Language, your native language
or the language you are using to create the macro.  
It displays all the words that are used in the macro – the macro title,
Piece and Style names, measurements, measurement picture names,
text objects in the pattern, and the “Next”,  "Back" and “Done” buttons
which appear in the macro when it runs.

At the top of the form we select to which language(column) the Base
Language has to be copied.  
Choose from English, Finnish, Dutch, German, Spanish, French or Italian.
 
(If you want to use some other language, please contact PatternMaker
Software for a program update.)

First we copy it to the language the macro is made in. In this case we
copy the base language to the English language column. 

Select the Language English, then click the Copy button. The list of
words has been copied to the English column.
In this column we do not need to change/translate anything because
English was the base language of the macro.

The objective is to enter words for each language that correspond to the text in the “base language” column.  There
are two ways to accomplish this:

EDIT IN THE GRID
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The most direct method is to copy first the base language to the right language column, then type directly into the
grid on the Translation form.  Just click into a cell of the table, and overwrite the word.

Select Dutch from the "Copy base language to:" pulldown
menu 
Then click the Copy button
All words are copied from the Base language column to the
Dutch column.
Just click into a cell of the table, and overwrite the word.
Type for:
Hood Collection Capuchon collectie
Next Volgende
Back Terug
Done Klaar
Klick OK when this is done. The translations are saved in
the .mg4 file

Not all the words need to be translated, for instance the name of an Text Object or a Groupe name need no
translation. Just the Text itself has to be translated. Therefore we have added T_ to the name of the text object and
a G_ to the Groupe name to make visible it  needs no translation.
Also names of measurement pictures need no translation when the picture is used in all languages. When you add
pictures with language on it, it could be necessary to make a difference between languages.

If there are many words to translate or somebody else has to translate the words, we have a second method to
translate the words:

EXPORT TO A SPREADSHEET
Click the “Export” button.  
A “Save File” dialog box opens.
Fill in:
Name the file:  Hood collection
Click Save  and the file is saved as a translation file ( .trf file) in the folder Translations in 
My Documents \ Patternmaker \ Personal Files \ Translations

We’ll be returning here in just a minute, so you can leave this form open.

You can now use Excel, Quattro Pro, or any other spreadsheet program to edit the translation tables.
Open your spreadsheet program
Use the “Open” or “Import” commands to open the file “Hood collection.trf” (select from All Files) as a tab-
delimited file.  
When it opens, it should look something like this:
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Add some words in the German column:
Hood Collection =  Kapuze Kollektion
Hood =  Kapuze
Next =  Nächste
Back =  Zurück
Done =  Fertig

Save the file.  Make sure it’s saved in the original .TRF format.  Do not let your spreadsheet program save in its
native format.
Go back to MacroGen and click the “Import” button on the Language Translations form.
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Select “Hood Collection.trf” and click the “Open” button.
The modified language translation file is imported into the grid.

 

When you convert your project file to a macro, all the languages automatically get built into the macro.

HOW PATTERNMAKER USES LANGUAGES
There is a setting in PatternMaker which determines what language it operates in.  When a macro is run, the
program tries to select the language for the macro that matches the PatternMaker language.  
If this is not possible (if PatternMaker is running in a language that does not exist in the macro), the macro will be
run in English, or in the “base language” if English is not present.
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PatternMaker is running in the Dutch version. 

The macro shows all Dutch translated words.

Note: at the moment the .mmt and the Measurement picture descriptions are not translated in MacroGen as well.
When you want these also translated you will have to do this manually with Notepad or a text editor. 
Be aware to save these files in a separate folder of the language because the names have to be the same.
Contact us for more instructions about this.
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8. Advanced Style Options
This lesson introduces techniques that you’ll need in order to create complex macros with conditional
measurements, style exclusions, sub-styles, and style pictures.  You may not need all of these features for every
macro you create, but they are worth learning because they give you a range of powerful effects at your disposal.

8.1 Add Pictures

Adding pictures to each style option is a great aid to your user.  Pictures show exactly what you mean for each
option description, and help clear up any confusion.

Load in the Sleeve project we’ve been working on
(BodiceWithSleeve4.mg4).

Under the Style Tree, from the Piece Sleeve, select "
Long Sleeve".
Then click on the "Picture field".

An “Open File” dialog box opens the folder Designers 
(My documents/PatternMaker/Personal Files/
Designers).

In the folder Tutorials you will find the file called
slv_pullover_long.jpg, 
select it and click the “Open” button.  

Note: The added picture should be a.jpg format and the
maximum size is 400x400 pixels. 

The selected picture of the long sleeve appears on the
Picture field.

Select the  "Short Sleeve" style option from the Piece
Sleeve.
Click on the "Picture field" and select in the folder
Tutorials the file called slv_pullover_short.jpg .
Click the “Open” button
The new picture is showing for this style.
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Remember:  Any time you select an style option , the selected style picture for this style is showing in the picture
field. 
It is not necessary to add a picture here to the parent style Sleeve because when a style has children the parent
style is not showed while running the macro.

 

Note: 

The two pictures that are included in this sample file are under copyright by Pro-Specs.  For
information about obtaining your own clip art from Pro-Specs, see the reference at the end of
this tutorial STILL EXISTS???????Can not find it

Now save your macro as BodiceWithSleeve5.mg4 and test it in PatternMaker. 
In the “Sleeve” dialog box, click on each option and notice how the pictures change.

Note: For being ab le to test the macro and see all the pictures that are added to the macro MacroGen copies and  saves
the pictures in the Designers test surrounding.
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8.2 Sub-Styles

Sub-styles form the “branches” of your Style Tree.  A Piece can have any number of Styles, but any Style can also
have sub-styles.  These are additional options that are available if the user has previously chosen a particular
option.

Begin by opening the sleeve project file, BodiceWithSleeve5.mg4.

We are going to add two sub-styles to the V-Neck bodice style: No Collar, and Simple Collar.  
This means that if the user chooses “V-Neck,” she will see another dialog box that looks like this:

The macro will then continue on to the Sleeve dialog box.  If the user chooses “Jewel Neck,” the macro will go
directly to Sleeve.

CREATE SUB-STYLES
First, we’ll create the windows for both sub-styles:

In the Style Manager, highlight “Bodice” in the Piece
List.
Highlight “V-Neck” in the Style Tree.
In the Name field, type “No Collar” and then click the
“Add Style” button.
Notice that “No Collar” appears under V-Neck.

Highlight “V-Neck” again in the Style Tree.
In the Name field, type “Simple Collar” and click the
“Add Style” button.

Now both sub-styles are listed under the “V-Neck”
bodice option.
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ADD POINTS FOR NEW COLLAR OPTION
Next we need to add some points to create this new collar item.

Double-click on “Simple Collar” in the Style Tree, or select it and click the Show button.  The “Simple Collar”
editing window opens.  At this point, it contains exactly the same points as its “parent” view, which is the V-Neck
bodice.

We only have to add two new points for the collar:
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Point / Add / Right Angle
Name:  SC1
From Point:  27
Corner Point:  28
(Fixed) Distance:  2
Direction:  Clockwise

Point / Add / Continue
Name:  SC2
Start Point:  29
End Point:  27 
Fixed Distance:  -2

After the points are added we can make the Simple Collar object.
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From the tabs:  Object/Add, 
Click "New" 
Name the new object "Simple Collar".

Connect the points in the drawing area
as follows:
27 (L)
28 (L)
SC1 (L)
SC2 (L)

Check the "Closed" box.
And click the ”OK” button to save the
object.

The drawing now looks like this (your drawing may have more points displayed, but we have turned them off for
clarity in this illustration):

Save the file as BodiceWithSubStyles.mg4 and test it in PatternMaker.  
Notice if you select the V-Neck bodice you get an additional dialog box with the two new options, “No Collar” and “Simple
Collar.”
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8.3 Style Exclusions

Style Exclusions are an extremely useful feature.  You will often find that you want to prevent a user from seeing a
particular style option if she has previously chosen an incompatible option.  
For example, if she chooses a “sleeveless” option, you don’t want her to then be presented with a choice of “long
sleeve or short sleeve.”

For this example we’ll add a new cuff piece to our pattern and this style option Cuff will not be available when one
selects a Short Sleeve.

ADD CUFF
Go to the Style Manager.
Select the Sleeve Piece because we want to add the new piece Cuff at the bottom. 
In the Name field, type “Cuff” and click the “Add Piece” button.

The  “Cuff” style is highlighted in the Style Tree.
In the Name field, type “No Cuff” and click the “Add Style” button.
Type “Square Cuff” in the Name field,  and click the “Add Style” button.
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We have now created a new Piece with two options:  No Cuff and Square Cuff.
Double click on “Square Cuff” or select it and click the Show button.
The drawing area opens of the Square Cuff style.

We have to add a few new points to form the Cuff piece.  We will arbitrarily make the cuff 3” wide.  (If we add this
cuff, we should be shortening the sleeve by 3”, but remember that these are just instructions on MacroGen
functions, not pattern drafting technique.)

Point/Add/Coordinate
Name: C1
From: S23
Y Offset: -3
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Point/Add/
Coordinate
Name: C2
From: S27
Y Offset: -3

Now, create a New Object using the tabbed panel.  (You remember how, by this time, right?)
Name: Square Cuff

Connect the points as follows:
S23 (L)
S27 (L)
C2 (L)
C1 (L)
Check the Closed box.

Now the “Square Cuff” editing window shows the result (again, points are turned off for clarity):
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SET EXCLUSION RULES
Close the “Square Cuff” window and go back to the Style Manager. The Square Cuff style needs to selected
(highlighted).
Click the >> button at the right bottom of the window.
Then click the Exclusions button.
The form Exclusion Rules opens.
In this form you can set that the current style will not be available (visible) when certain styles have been
selected.
In the column Style List at the left all the available styles and sub-styles before the current style are listed.
Put a mark in the “Short Sleeve” check box.
Click the “Add” button. 
 “Short Sleeve” appears in the Exclusion Combinations column.
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This means that the current style [Square Cuff] will not be available when the user has previously selected the
style [Short Sleeve].

Notice how you can create numerous combinations using this technique.  
For example, you could create a rule that the [Square Cuff] style is not availab le if the user selects both
[Jewel Neck] and [Short Sleeve] – that is, you might decide that if she selects either of the V-Neck options,
it’s okay to have [Square Cuff] availab le.

You can set up an OR condition (the [current style] is not availab le if the user chooses either [Style 1] or
[Style 2]) by checking the first style and clicking the “Add” button, then checking the second style and
clicking the “Add” button.

You can set up an  AND condition (the [current style] is not availab le if the user chooses both [Style 1] and
[Style 2]) by checking both styles at once before clicking the “Add” button.

There’s only one Exclusion Rule in this case, so click the “OK” button to close the form.

Save the macro as BodiceWithStyleExclusions.mg4 and test the different paths in the macro in PatternMaker. 
Notice how the “Square Cuff” option only appears when you select “Long Sleeve” for the sleeve option.
After testing close PatternMaker without saving changes. You will return to MacroGen
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8.4 Style Dependent Measures

The final feature we will cover in this lesson is Style Dependent Measures.  Style Dependent measures are often
used together with style exclusions, but as you will see, they have a different effect, and can also be used
independently.

You already know how to create prompted measurements.  These are used in virtually every macro.  Style
depended measures are also prompted, but they only appear if the user has chosen a particular style.  These
measurements will not appear in all “paths” of the macro.  For example, let’s say you have a pants macro that
offers two styles: zipper waistband or elastic waistband.  If the user chooses “elastic waistband,” you don’t want a
prompted measurement asking for the zipper length.

ADD A NEW STYLE
To illustrate the Style Dependent measures, we’re going to add a new style to our Bodice.

Open the project BodiceWithStyleExclusions.mg4
In the Style Manager select “Cuff” in the Piece List.
“Cuff” in the Style Tree is highlighted. 
In the Name field, type “Flared Cuff,” and click the “Add Style ” button.

Double-click “Flared Cuff” to open its editing window.

ADD STYLE DEPENDENT MEASURES
Now we need to define the style dependent measures.  

From the tabs, select Measure / Add / Prompted. The Prompted measurements form opens.
In the name field New is already highlighted, you can overwrite this with the new measurement name Cuff
Depth  with a default value of 3.
Check the Style Dependent box to indicate that this measurement is used only in some styles.
Click the Save button at the bottom left to save the new measurement in the Measurements list at the right.
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Click the “New” button at the left bottom to create a second measurement called “Cuff Flare” with a default value
of 1.5.
Check the Style dependent box.
Click the Save button at the bottom left.  
Click the OK button at the right bottom to save you added measurements. 

After saving the Style Dependent measurements, in 
Measure/Edit a D behind a measure indicates that the
Style Dependent box is checked
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ADD POINTS AND CREATE NEW OBJECT
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Point/Add/Coordinate
Name: C3
From: S23
(to enter points faster type S23 and MG will jump to
S23, click at it and it is selected)

X Measure: Cuff Flare
X Scale: -1
Y Measure: Cuff Depth
Y Scale: -1

Point/Add/Coordinate
Name: C4
From: S27
X Measure: Cuff Flare
X Scale: 1
Y Measure: Cuff Depth
Y Scale: -1
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From the tab Object, create a new object:

Name: Flared Cuff

(If you can't see your new points, go back and make sure no
options are showing for the Bodice and Sleeve Pieces, and then
double-click on the Flared Cuff style to open your Style Window.)

Connect the points as follows:
S23 (Line)
S27 (Line)
C4 (Line)
C3 (Line)
Check the Closed box.
Click OK to save you Flared cuff object

The drawing now displays the flared cuff piece.

SET STYLE DEPENDENT MEASURES 
Now we will assign these style dependent measurements to a particular style, here the Flared Cuff style.  

Close the Tabs panel (and the drawing area) and go back to the
Style Manager.
Select the “Flared Cuff” style (highlighted).

Click the Advanced >> button at the right bottom of the window.

The Dependent Measures form opens.
In this list all Prompted measurements are displayed, a D behind
a Prompted Measurement indicates that the Style Dependent box
is checked. This is also displayed in the list of all measurements
in Measure/Edit 
Put a mark in the “Cuff Depth” check box, and put a mark in the
“Cuff Flare” check box.
Note: This is not possib le when the Style Dependent box is not
checked in the Prompted Measurement form (no D visib le behind the
measure).

. 

The checked measurements Cuff Depth and Cuff Flare will only be displayed when the user chooses the style
Flared Cuff.
In all the styles where these boxes are not checked (everywhere except this one style) these two measurements
will not be displayed to the user while running the macro.

And finally, since this flared cuff doesn’t really make sense on a short sleeve, let’s create an exclusion rule for this
style Flared Cuff as well.

Click via the Advanced >> button the Exclusions button.
Put a mark in the “Short Sleeve” check box, and click the “Add” button. 
The Short Sleeve is added to the column of Exclusion Combinations.
Click "OK."
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TESTING THE RESULTS
Now save the macro once again and select “Test Macro in PatternMaker.”  Go through all the style options and
admire the features you’ve added – pictures, sub-styles, style exclusions, and style dependent measurements.
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9. Working with Logic
Let's think about logic.  It's common in patternmaking to be faced with a decision of the form "If X happens, then do
Y."  For instance, your pattern may use a side dart only if the bust is larger than a certain size.  IF statements are
common in computer programming languages, and the PatternMaker macro language is no exception.  But how do
we make logical choices in MacroGen?

We are going to use logical choices to modify a dart.  To start with we will create an ultra-simple piece, a square
toga.  (You can think of the square part as being a placeholder for the rest of a normal bodice, which we will not
use in this tutorial.)  You may open the MacroGen project file "Dart Start.mg4" or make it yourself by following the
next section

9.1 Dart Test Project

Setting up 
We're going to create a macro that uses a few simple measurements to make a dart of variable width and depth.  In
the subsequent sections of this tutorial, we'll use this dart to demonstrate various logical decisions.  The set-up
work in this section has already been done for you, so if you think you understand what follows and don't need the

practice, you can skip to the end of this section and open the project file "Tutorial - Dart Test.mg4".

Start new Project
Settings/Metric: checked
Macro Title: Dart Test
Add Piece: Toga
Open the Toga style.
It will require two prompted measurements, Height and Width, and a math measurement "Dart Width" with a fixed
distance 1.  

Measure / Add / Prompted Measure
Name: Width
Value: 10.0
Save the measurement at the left bottom.
Click New
Name: Height
Value: 10.0
Save the measurement at the left bottom.
Click Save at the right bottom to exit the form.

Measure / Add / Math 
Name: Dart Width
First Measure: (None)
Second Measure: (None)
Fixed Distance: 1.0

Now we add some points to create a simple square.
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Point / Add / Coordinate
Name: 1
From: Start
X Fix. Distance: 5

Point / Add / Coordinate
Name: 2
From: 1
X Measure: Width
X Scale: 1

Point / Add / Coordinate
Name: 3
From: 2
Y Measure: Height
Y Scale: 1

Point / Add / Rectangle
Name: 4
X Coordinate: 1
Y Coordinate: 3

The depth of the dart will be 1/6 of the diagonal measurement of our square.  
Create a Distance measurement named "Dist 1-3" which is the distance between Points 1 and 3.
Next create a Math measurement for the Dart Depth

Measure / Add / Distance
Name: Dist 1-3
From Point:  1
To Point: 3

Measure / Add / Math
Name: Dart Depth
First Measure:  Dist 1-3
First Measure scale: 6

Now, for the dart points.  Create the following points:

Point / Add / Center
Name: DC
From:2
To: 3

Point / Add / Coordinate
Name: D1
From: Dart Center
Y Measure: Dart Width
Y Divisor: -2
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Point / Add / Coordinate
Name: D2
From: Dart Center
Y Measure: Dart Width
Y Divisor: 2

The apex of the dart:
Point / Add / Coordinate
Name: D3
From: Dart Center
X Measure: Dart Depth
X Divisor: -1

Note: As a little review of things we learned in Tutorial 2, notice the order of the events above:  we had to create Points 1-3
before we could calculate the measure Dart Depth, and we had to calculate Dart Depth before we could add the dart
points.

Create an object 
Object / Add / New 
Name:  Toga
1 (Line)
4 (Line)
3 (Line)
D2 (Line)
D3 (Line)
D1 (Line)
2 (Line)
Closed: checked
OK

The object looks like this:

You may open the MacroGen project file "Tutorial - Dart Test.mg4" now if you want to skip the above work.

9.2 Changing the dart with logic

Now for the interesting part.  Often a dart needs to be adjusted depending on measurements in a more complicated
way.  If some measurement is too small a dart may not be included, or in other situations a dart may be added. 
We are going to take a look at 3 ways to remove this dart depending on a measurement.   We are going to base
this on the measurement "Dart Depth".

Our pattern designer tells us that in this pattern, if the dart depth is less than 2 cm, we should leave the dart out. 
This calculation will depend on the width and height value of the user.  
How to program the decision?  
We're going to show you three different ways.  They use different MacroGen features to get the same end result:  
if the dart depth is less than 2 cm, it doesn't draw the dart.  
Here are the three ways we're going to do it:

CONDITION:  "IF THE DART DEPTH IS LESS THAN 2 CM."

1. Use an If Point to change a measure.  
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If the condition is true, set the dart depth to 0.
2. Use an If Point to change the type of a point.  

If the condition is true, change point D3 from a Coordinate Point to a Center Point, centered between D1 and D2.
3. Use a Code Point to change a property of an object.  

We will draw the dart as a separate object from the square.  If the condition is true, hide the dart object.
The Dart Test project is opened.

Open in the Style Manager the Toga style and from there, open the Logic form via Menu / Points / Logic.
This logic form is connected to the style Toga, it is therefore important to make the logic in the right style! 

In the Logic form:
Click: New Step
The Steps form opens.
Select : Dart Depth < 2
The name of the step is a result of selecting the values

Click: OK
The Step is visible in the Logic form

In the Logic form, add a new result to go with this condition:
Highlight the Step:  if 2 > Dart Depth
Click: New Result
The Edit measure form opens.
Highlight: Dart Depth
Click: OK
The Math form of Dart Depth opens.  
Dart Depth is defined as 1/6 of the calculated Distance Measure Dist 1-3.  Change the measure to 0:
First Measurement: (None)
Click: OK

In the Logic form the result is:

TESTING OUR LOGIC
If we change the default height and width of our square, the piece display updates to show the current line of logic.
Remember that the dart depth depends on the Height and Width.  If we change Width to a value such that Dart



Tutorial 9. Working with Logic 147

© 2003-2015 PatternMaker Software

Depth goes below 2, we should see the dart disappear in the piece display--a quick test without running the
macro.

Open the style Toga.
Measure / Edit
Highlight: Width
Click: Edit
Value: 6
Click: OK

Arranging If Points in Order

This is wrong.  We told it if Dart Depth is less than 2, to set Dart Depth to zero.  Yet Dart Depth is 1.94.  Why is
this?  The reason is subtle but important.  It has to do with the order of our logical steps.  By default, the If points
are calculated after the measurements are typed in by the user.  This happens before any of the drawing points are
calculated.  Yet Dart Depth is dependent on the distance between points 1 and 3.  We need to place the If Point
after the creation of Point 3.

Point/If Point
Check: Show all points

You used this dialog box in Tutorial 3, but with "Show All Points" unchecked.  Now all the point calculations are
shown in the order in which they happen.  Drawing point calculations are in red, If points are in black.  Here we see
that our If point happens before point 3 is calculated.  Use the big black arrows on the left of the dialog box move it
down in the list.
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Highlight:  if 2 > Dart Depth
Click the down arrow 3 times

Click Ok

This gives us:

This is what we expected.  This is the first way to create an "if" condition.

Your project  should now be the same as the one in project file Dart Measure.mg4.
If you haven't been following this tutorial from the beginning, open project file Dart Measure.mg4.  

Delete a Code Point Result

We are now going to try our second method for deleting the dart.  Instead of changing the measure Dart Depth, we
are going to change the definition of the point D3, the dart apex.  The Condition part of the If Point that we just
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created stays the same, but we're going to change the result.  First, delete the old result:

Point/If Point
Show All Points: checked (optional)
Highlight: if 2 > Dart Depth

A result, "Dart Depth = 0", appears in the Results list.

Highlight: Dart Depth = 0
Click the red X on the right

Point D3 is defined as a Coordinate point.  Now, if 2 > Dart Depth, we are going to redefine D3 as a center point. 
Remember how we just saw that the order of our If points is important?  First of all we have to move the If point after
the creation of D3.

Click the down arrow 4x
Advanced Results>>: Click
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In the IfAdvancedChoices form,

Modify Point: Selected
D3: Highlicht
Ok: Click

This displays the original definition of D3.

Change: Click
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We'll put point D3 in the center between points 1 and 2, effectively eliminating the dart.

Highlight Center
Click OK

From: 1
To: 2
OK: Click
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This yields

Click Ok

This gives the same drawing we saw before.  You can change the default value of the measure Width back and
forth between 6 and 10 to verify it works.  

Printing a Report

If you try to edit D3 you'll notice it is a Coordinate point, yet it is centered.  This can be confusing.  How can we tell
that D3 is modified?  As your MacroGen projects get more complicated than this example, it will become more and
more difficult to keep track of all the steps by just looking at the screen.  You need to see a full report.  This
function is found under the File menu.

File/Report
Points: Selected
OK: Click

You'll get a large table.  Each row in the report gives details on a step in the point calcutlations.  At the bottom,
you'll see D3 is modified by an If point:
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Close: Click

Your project  should now be the same as the one in project file Dart Point.mg4.
If you haven't been following this tutorial from the beginning, open project file Dart Measure.mg4.  

Delete a Code Point Result

Our third way of eliminating the dart uses a Code Point rather than an If Point. First we need to delete the If result
again.

Point/If Point
Highlight "if 2 > Dart Depth"
Highlight Result "D3"
Click Delete X (right side)
Close the form

This time, we're going to create two objects:  the original object with the dart, and an alternate version with no dart.
Depending on whether we want the dart, our Code Point will hide one object and show the other.

Draw an object without a dart.

Object/New Object...
Name: No Dart
Closed: Checked
Left-click: Start
Left-click: 1
Left-click: 2
Left-click: 3
Click "OK"

Your new object will be hard to see because object Dart obscures it--that's OK:
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From the top-level menu, bring up the If Point form again.

Point/If Point

Highlight: "if 2 > Dart Depth"
Click "Advanced Results"

In the IfAdvancedChoice form,

Check: Add Code Point
Click OK

The CodePoint form is an advanced MacroGen feature for programmers.  This tutorial will only touch on its use. 
We can select the type of entity we want to modify (object) from the Type pulldown, select the object from the List
pulldown, and select an object property we wish to change from the Accel pulldown.  The big text area at the
bottom of the form is for entering macro code directly--that is beyond the scope of this tutorial. 
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"Hide Dart" is the object we want to modify.

Name: Hide Dart
Type: Object

The List pulldown lists the objects we've defined in the macro.  The extra characters are part of the internal code
MacroGen uses.  Look for the name of the object we're interested in, which is "Dart".  Go to the "List" pull-down:

List:  @Object[Dart]

Accel: Select Hide

This tells it we want to modify the hide property of the dart object
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Click the Paste Button

This types in the code @Object[Dart].Hide

Change the text so it looks like:

mailto:@Object[Dart].Hide
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@Object[Dart].Hide = 1;

which is a statement in the Patternmaker macro language.  (For the Hide property, 1 means hide it; 0 means show
it.)

Click Ok

In doing this we've told the program to hide the Dart object if 2 > dart depth

Now to hide the other object.  The "No dart" object is hidden when our condition is false--much like the "Else"
branch of an IF statement in many programming languages.  To program this branch, check the False radio button
on the If form.

Check False
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Click Advanced Result
Check: Add Code Point
Click OK

Name:  Hide No Dart
Under Type, Select "Object" 
Under List, Select @Object[No Dart]
Under Accel, Select Hide
Click the Insert Button
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Change the code to look like 

@Object[No Dart].Hide = 1;
Click OK

There you have it:  if the condition "2 > Dart Depth" is true, then the Code Point hides object "Dart".  If the condition
is false, it hides object "No Dart".  To check your work, change the value of the measure Width from 10 to 6 and
back to verify that the If block works.  You should see the dart appear and disappear as either object "Dart" or "No
Dart" is displayed.

Your project  should now be the same as the one in project file Hide Object.mg4.
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